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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©July 2015

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
I



Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

• Off Mode < 0.5W
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CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.

Energy Star©
Energy Star© is a registered trademark of the U.S Environmental Protection Agency (EPA). As an En-
ergy Star© partner, the manufacturer of this computer has determined that this product meets the En-
ergy Star© guidelines for energy efficiency.
III
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FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN mod-
ules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on,
make sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.
VI
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
VII
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VIII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and
power cord). 

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
IX
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
X
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
XI
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

• Hazardous moving parts.
• Keep away from moving fan blades.
XII
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
XIII
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XIV
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level 
of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a 
footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when 

you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and 

short breaks are better than fewer and longer breaks.
XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.
XVI
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
card reader & ExpressCard), Touchpad & Mouse & Audio.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s PC Camera, Wireless LAN, Fingerprint Reader, 3G/4G, Blue-

tooth and Trusted Platform (TPM) modules (some of which may be optional depending on your 
purchase configuration).

• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Control Center.
• Appendix C Information on the video driver controls.
• Appendix D The computer’s specification.
• Appendix E A guide to the Docking Station.
• Appendix F Information on the Windows 10 operating system.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.



Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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System Startup
1. Remove all packing materials and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an

outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 135 degrees); use the other 

hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Press the power button on the top right of the computer for about 2 - 3 seconds to turn the computer on

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In


Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the bottom right of
the Start menu in Win-
dows. This will help pre-
vent hard disk or system
problems.

135°
1 - 4 System Startup
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 (64-bit) operating system
is supported. 

Model Differences
This notebook series includes two different models that vary slightly in design style, color, general appearance
and features supported (see Appendix D for full details). Note that your computer may look slightly different
from that pictured throughout this manual.


Windows Versions

Note that the information included on the following pages is for Windows 8.1 (64-bit) only.

Windows OS

In order to run Windows 8.1 (64-bit) without limitations or decreased performance, your computer requires a minimum
2GB of system memory (RAM).
System Startup 1 - 5
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System Map: LCD Panel OpenFigure 1 - 2
LCD Panel Open

1. Built-In PC Camera 
(Optional)

2. PC Camera LED
3. LCD
4. Power Button
5. LED Indicators
6. Keyboard
7. Built-In Microphone
8. Touchpad & 

Buttons
9. Fingerprint Reader 

Sensor

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

9

3

5

1

4

6


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft is
usually prohibited. Make
sure the module(s) are
OFF if you are using the
computer aboard aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED in-
dicator for the power sta-
tus (see Table 1 - 3, on
page 1 - 10).

7

9

8
5

2

1 - 6 System Map: LCD Panel Open
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LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.

Table 1 - 1 - LED Indicators

Icon Color Description Icon Color Description

Orange AC/DC Power is Plugged In Green
Airplane Mode is ON (the WLAN, 

Bluetooth & 3G/4G Modules are OFF)

Blinking 
Orange

The Powered USB Port is On Blue Power Button

Green The Computer is On Green Hard Disk/ODD Activity

Blinking 
Green

The Computer is in Sleep Mode Green Number Lock Activated 
(to activate press Fn & Num Lk)

Orange The Battery is Charging Green Caps Lock Activated

Green The Battery is Fully Charged Green Scroll Lock Activated 
(to activate press Fn & Scr Lk)

Blinking 
Orange

The Battery has Reached Critically 
Low Power Status

The powered USB 3.0 port (see Figure 1 - 6 on page 1 - 13) may be toggled on /off by means of the Fn + Power Button
key combination. When the powered USB port is on it will supply power (for charging devices only, not for operating devices)
when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with
a capacity level above 20% (this may not work with certain devices).
LED Indicators 1 - 7
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly. 

Figure 1 - 3 - Keyboard


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.

Numerical Keypad 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

Windows Logo Key

Menu/Application Key



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 8 Keyboard
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Keyboard Shortcuts
The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-
gation/operation in Windows 8.1.

Table 1 - 2 - Keyboard Shortcuts

Windows Logo 

 Key + 
Description

Tap Winkey
Toggle between the Start screen and the foremost running app or the 

Windows Desktop

C Display Charms menu

D Switch to the Windows Desktop and toggle show Desktop 

E
 Switch to the Windows desktop and launch Windows Explorer with 

Computer displayed

F Display file Search

I Open the Settings charm

K Open the Connect charm

L Lock the computer and display the Lock screen

P  Display the Second Screen menu (see Figure 1 - 19 on page 1 - 28)

R Switch to the Windows Desktop and display the Run dialog box

Z Access the Customize Bar (see Figure 1 - 14 on page 1 - 23)


Windows Logo 

Keyboard Shortcut

Use the Windows logo
key  + D key com-
bination to switch
from the Start screen
to the Windows Desk-
top.

Menu/Application 
Keyboard Shortcut

When the Desktop app
is running you can use
the Menu/Application
key  on the key-
board to act as a
mouse right-click. In
the Start screen this
function is useful to
quickly display Cus-
tomize Apps.
Keyboard 1 - 9
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Keys Function Keys Function

Fn + Play/Pause (in Audio/Video Programs) Fn + Brightness Decrease/Increase 

Fn + 
Touchpad Toggle 

(Disable toggle by using 
the Touchpad Switch)

Fn + PC Camera 
Power Toggle 

Fn + Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on)

Fn + Airplane 
Mode Toggle 

Fn + Mute Toggle Fn + NumLk
Number Lock 

Toggle 

Fn + Sleep Toggle Fn + ScrLk
Scroll Lock 

Toggle

Fn + Volume Decrease/Increase Caps Lock
Caps Lock 

Toggle

Fn + Display Switch Menu

Fn + 

Fan Control 
Toggle - 

Automatic 
Fan Control / 
Full PowerTable 1 - 3 - Function & Hot Key Indicators
1 - 10 Function/Hot Key Indicators
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Control Center
When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click the icon  in the notification area of the taskbar to toggle the Control Center on/off. The Con-
trol Center gives quick access to frequently used controls and enables you to quickly turn the camera/touch pad
on/off (see Appendix B for full details). 

Figure 1 - 4 - Control Center


Control Center Access

To run the Control Center press the Fn + Esc key
combination, or double-click
the icon  in the notification
area of the taskbar. 

Close the Control Center by
clicking the  close icon in
the top right of the panel
(move the cursor onto the top
right corner of the panel to
highlight it).
Control Center 1 - 11
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System Map: Front & Top ViewsFigure 1 - 5
Front & Top Views 

(with Optional 
Docking Station)

1. Touchpad Switch
2. LED Indicators
3. Docking Station 

(Optional)


Touchpad Switch

Use the Touchpad
Switch to disable the
touchpad toggle function
(i.e. the use of the Fn +
F1 key combination).

When the switch is in the
OFF position, then the Fn
+ F1 key combination will
be disabled.



Docking

.If your purchase in-
cludes the docking sta-
tion, open the docking
port cover latch and
align the computer
with the placeholder
on the docking station
(see the accompany-
ing docking station for
full details of the dock-
ing procedure).

3

1 2

2

1 - 12 System Map: Front & Top Views
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System Map: Left View Figure 1 - 6
Left View

1. DC-In Jack
2. External Monitor 

Port
3. RJ-45 LAN Jack
4. e-SATA Port
5. AC/DC Powered 

USB 3.0 Port
6. 2 * USB 3.0 Ports
7. HDMI Out Port
8. Multi-In-1 Card 

Reader
9. ExpressCard Slot


USB Ports

This model includes 3 *
USB 3.0 ports (including
one ACDC Powered USB
3.0 port) and 1* USB 2.0
port. USB 3.0 ports are
denoted by their blue col-
or; USB 2.0 ports are col-
ored black.

2
541

3


Multi-In-1 Push-Push Card Reader

The card reader allows you to use the most popular dig-
ital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

MS (Memory Stick) / MS Pro / MS Duo

Powered USB 3.0 Port

The powered USB 3.0 port  can supply power (for
charging devices only, not for operating devices) when
the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery
with a capacity level above 20% (this may not work with
certain devices - see page 8 - 11). Toggle power to this
port by using Fn + power button. Power to this port may
be enabled/disabled in the BIOS (see page 5 - 10).

5

6
7 8

6


External Monitor Port & RJ-

45 LAN Jack

If you are using a VGA cable
plugged into the external
monitor port, and a network
cable connected to the RJ-45
LAN jack, it is recommended
that you insert the VGA cable
before inserting the LAN ca-
ble.

USB Port / Card Reader / 
ExpressCard Power

Note that power to the USB
ports, card reader and Ex-
pressCard may be enabled/
disabled in the BIOS (see
page 5 - 10).

9

System Map: Left View 1 - 13
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System Map: Right & Rear ViewsFigure 1 - 7
Right & Rear Views

1. Microphone-In 
Jack

2. Headphone-Out / 
S/PDIF Out 
Combo Jack

3. 1 * USB 2.0 Port
4. Optical Device 

Drive Bay (for CD/
DVD Device)

5. Security Lock 
Slot

6. Battery

1 2 3 4

65


Headphone / S/PDIF Out Combo Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s vol-
ume to a reduced level before connecting to this jack. As a S/PDIF (Sony/Philips Digital In-
terface Format) Out Port, this allows you to connect your DVD-capable PC to a Dolby AC-
3 compatible receiver for “5.1” or ‘dts’ surround sound.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges.
1 - 14 System Map: Right & Rear Views
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.


Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
System Map: Right & Rear Views 1 - 15
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System Map: Bottom View Figure 1 - 8
Bottom View

1. Battery
2. Docking Port
3. Fan Intake/Vent
4. Component Bay 

Cover
5. HDD Bay Cover
6. Speakers


Battery Information

Always completely dis-
charge, then fully
charge, a new battery
before using it. Com-
pletely discharge and
charge the battery at
least once every 30 days
or after about 20 partial
discharges.

2

1

4


CPU

The CPU is not a user ser-
viceable part.

Overheating

To prevent your computer
from overheating make
sure nothing blocks the
Vent/Fan Intake while the
computer is in use.

6

5 3
3

3

6


Docking Port Cover

If your purchase option includes the docking station, make sure you keep the cover
closed when the computer is not docked in the station. This will help prevent foreign objects
and/or dust getting in to the contact area.
If your purchase option does not include the docking station, an insert will be provided
to prevent accidentally opening the docking port. Do not attempt to open the cover or re-
move the insert in this case.
1 - 16 System Map: Bottom View



Quick Start Guide 1
3G/4G Module USIM Card Installation
If you have included an optional 3G/4G module in your purchase option, follow the instructions below to install
the USIM card (which will be provided by your service provider), and then use the Charms Bar Wireless icon
to access the 3G/4G network in the same manner as the WLAN (see page 7 - 69).

1. Turn off the computer, and turn it over and then remove the battery (slide the latches in the direction indicated 
below and slide the battery out).

2. Insert the USIM card into the slot at the rear of the battery compartment, as illustrated below, until it clicks fully 
into position, and replace the battery.

Figure 1 - 9 - Battery Removal & USIM Card Insertion


USIM Card 
Orientation

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
upwards as illustrated.
3G/4G Module USIM Card Installation 1 - 17
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Docking Port
Follow the instructions below before connecting the computer to the docking station, if included in your pur-
chase configuration. Failure to open the cover of the docking port before connecting the computer to the docking
station may result in irreparable damage to the connector on the docking station.

1. Turn the computer over.
2. Slide the docking port cover latch in the direction of the arrow at point  to open the cover.
3. After disconnecting the computer from the docking station, slide the docking port cover latch in the direction of 

the arrow at point .

1

2


Docking Port 

Cover

Make sure you keep
the cover closed
when the computer is
not docked in the sta-
tion. This will help
prevent foreign ob-
jects and/or dust get-
ting in to the contact
area.

1

2

Figure 1 - 10 - Opening and Closing the Docking Port
1 - 18 Docking Port
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Windows 8.1 Control Panel
Throughout this manual you will see an instruction to open the Control Panel.
Right-click the lower left hot corner to bring up the context menu (or use the Win-
dows Logo Key  + X key combination) and select Control Panel in both the
Desktop app or Start screen.

Figure 1 - 11 - Windows Context Menu


Windows Versions

Note that the informa-
tion included on the fol-
lowing pages is for the
latest updated version
of Windows 8.1 only.

Make sure you enable
Windows Update in or-
der to get all the latest
security updates etc.
(see “Windows Up-
date” on page 4 - 8).

 

   

Move the mouse to the bottom left 

   

Start Screen

Desktop app

of the screen and right-click to
access the menu. 
Windows 8.1 Control Panel 1 - 19
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The Control Panel can be accessed in a number of ways in Windows 8.1.

• Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type 
Control Panel and select it from the results to the left.

• Click on This PC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the 
top menu and select Open Control Panel from the ribbon.

• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows 
Charms Bar and select Control Panel from the menu.

• Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

• Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 12 on page 1 
- 21).


Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key  and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key  and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
1 - 20 Windows 8.1 Control Panel
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Right-click the Start button in the Desktop app (or use the Windows Logo Key

 + X key combination) to bring up an advanced context menu of useful features
such as Control Panel, Programs and Features, Power Options, Task Manager,
Search, File Explorer, Command Prompt, Device Manager and Network Connec-
tions etc.

Figure 1 - 12 - Advanced Context Menu (Right-Click Start Button)


Display Most 

Recently Used 
Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app. 

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen 

and right-click the Start button to access the menu.
Windows 8.1 Control Panel 1 - 21
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Windows 8.1 Start Screen & Desktop
The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows Logo Key  + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 13 - Windows Start Screen

Desktop App
1 - 22 Windows 8.1 Start Screen & Desktop
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Apps & Tiles
The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on an app to bring
up the context menu and you pin the App to (or unpin from) the Start screen, or to the taskbar.

Figure 1 - 14 - Apps

 
 

Click the arrow at the bottom of the 
screen to access All Apps 
Windows 8.1 Start Screen & Desktop 1 - 23
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Desktop Application
When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key  + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

Figure 1 - 15 - Desktop

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
1 - 24 Windows 8.1 Start Screen & Desktop
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The Charms Bar
The right side of the screen (Start or Desktop) displays the Charms Bar. The Charms Bar contains the Search,
Share, Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower
right corners of the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will
be black when it is active), or use the Windows Logo Key  + C key combination. 

Figure 1 - 16 - Start Screen with Charms Bar

 

Move the mouse over a Charms Bar icon to activate the menu 

Move the mouse to the top/lower right icons to activate the Charms Bar 

Move the mouse to the top/lower right icons to activate the Charms Bar 
Windows 8.1 Start Screen & Desktop 1 - 25
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Charms Bar Items

• Search : You can search for any file, application, Apps and control panel settings with instantaneous 
results.

• Share : This button is used to share information with people via mail or social networks.

• Start : Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen). 

• Devices : Click this button to change connected peripheral device settings e.g. an external display.

• Settings : This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

Figure 1 - 17 - Settings Menu


Charms Bar - TouchPad Access

To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the 
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.
1 - 26 Windows 8.1 Start Screen & Desktop
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Windows 8.1 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar (system tray). In Windows 8.1 the taskbar can be directly accessed from the Desktop application; if you
are in the Start screen you will need to move the cursor to the bottom of the screen to display the taskbar.

The taskbar is displayed at the bottom of the screen, and you can see the notification area (system tray) of the
taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 18 - Taskbar & Notification Area (System Tray)

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing
Pining/Unpinning All Apps” on page 1 - 23).
Windows 8.1 Start Screen & Desktop 1 - 27
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows when running the Desktop app (see “Desktop Application” on page 1 - 24).
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The
Charms Bar” on page 1 - 25).

To Configure Displays from Devices (Charms Bar):
1. Attach your display to the appropriate port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen

only.

Figure 1 - 19 - Devices (Project)
1 - 28 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Figure 1 - 20 - Screen Resolution

1

3

2


Right-Click Desktop 

App

1. You can right-click 
the desktop and 
select Screen reso-
lution  (Figure 1 - 
20).

2. Use the dropbox to 
select the screen 
Resolution  
(Figure 1 - 20).

3. Click Advanced 
settings  (Figure 
1 - 20) to bring up the 
Advanced 
properties tabs.

1

2

3
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To access the Intel(R) HD Graphics Control Panel:
1. Click Advanced settings  (Figure 1 - 20 on page 1 - 29) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab and click Graphics Properties (button)  (Figure 1 - 21 on page 1 - 30) .
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon  in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 21 - Intel Graphics Control Panel

3

4

4
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Set-
tings in the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hibernate/
Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Figure 1 - 22 - Shut Down/Restart 

Charms Bar

Desktop App Start ScreenPower Button Start Screen
Power Options 1 - 31
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Running Apps
To run apps in Windows 8.1 you will need to check that the Screen Resolution and User Account Control Set-
tings are compatible with the system requirements.

Screen Resolution Settings
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + D key combination).
2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to

make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Figure 1 - 23 - Screen Resolution


Screen Resolution for Apps 

(Windows 8.1)

The minimum resolution in which Apps will run is 1024x768. 

The minimum resolution required to support all the features of
Windows 8 (including multitasking with snap) is 1366x768. 

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size. 
1 - 32 Running Apps
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User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.
2. Click on User Accounts and then click on Change User Account Control settings (or click System and

Security and click Change User Account Control Settings under Action Center).
3. If the slider is in the Never notify position, then the UAC is disabled. 
4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes

to my computer (default) position, and then click OK. 

Figure 1 - 24 - User Account Control
Running Apps 1 - 33
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Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• Multi-In-1 Card Reader
• ExpressCard Slot
• Touchpad and Buttons/Mouse
• Audio Features
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height
of 9.5 mm or 7 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Optical (DVD) Device” on page 6 - 5.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripheral
cables, including phone
lines, are disconnected
from the computer.

Figure 2 - 1
Hard Disk Location

HDD Bay
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page D - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 13).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.


Sound Volume 

Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 13).

 Figure 2 - 2
Optical Device

1

2

3

1
2 3
Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes:

1. Go to the Control Panel 
2. Double-click Device Manager (Hardware and Sound), then click the + next to 

DVD/CD-ROM drives. 
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 

select the DVD Region (tab) to bring up the control panel to allow you to adjust the 
regional code.


DVD Region Note

DVD region detection is
device dependent, not
OS-dependent. You can
select your module’s re-
gion code 5 times. The
fifth selection is perma-
nent. This cannot be al-
tered even if you change
your operating system
or you use the module in
another computer.

 Figure 2 - 3
DVD Region Codes

• Region 1 - USA & Canada

• Region 2 - Western Europe, Japan, 
South Africa, Middle East & Egypt

• Region 3 - South-East Asia, Taiwan, 
South Korea, The Philippines, Indo-
nesia, Hong Kong

• Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand

• Region 5 - N Korea, Russia, Eastern 
Europe, India & Most of Africa

• Region 6 - China
Optical (CD/DVD) Device 2 - 5
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 Multi-In-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“CardReader” on page 4 - 7.

Note: Some of these cards require PC adapters that are usually supplied with the
cards.


Push-Push Card 

Reader

The card reader fea-
tures a push-in/push-out
card insertion and ejec-
tion mechanism. Simply
push the card to insert
and eject it, however MS
Duo cards require an
adapter.

 Figure 2 - 4
Left View

1. Card Reader

• MMC (MultiMedia Card) / RS MMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC
• MS (Memory Stick) / MS Pro / MS Duo

1

2 - 6 Multi-In-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 7).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place (as 

pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.


ExpressCard 

Slot Cover

Make sure you keep the
cover provided in the
ExpressCard slot when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the ExpressCard Slot.

 Figure 2 - 5
Left View

1. ExpressCard 
Slot

1

ExpressCard Slot 2 - 7
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 Touchpad and Buttons/Mouse
The Touchpad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse.

Once you have installed the Touchpad driver (see “Touchpad” on page 4 - 7) you
can configure the functions by double-clicking the Touchpad driver icon  in the
notification area of the taskbar. You may then configure the Touchpad tapping, but-
tons, scrolling (see sidebar), pointer motion and sensitivity options to your prefer-
ences.


Touchpad Scrolling

This computer model se-
ries may feature different
Touchpad versions.

These Touchpads may
differ in their vertical
scrolling function in most
scrollable windows.

Some Touchpads require
sliding the finger up and
down on the right of the
Touchpad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
Touchpad to scroll the
window.

 Figure 2 - 6
Mouse Properties
2 - 8 Touchpad and Buttons/Mouse
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 7
Mouse Properties - 

Device Settings
Touchpad and Buttons/Mouse 2 - 9
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Disabling the Touchpad
If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when
resting your wrists or palms on it) you can do so by using Fn + F1 key combination.

You can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g. a USB mouse) is attached.

1. Go to the Mouse Properties control panel.
2. Click to select Device Settings (tab).
3. Click to place a check in the “Disable internal pointing device when external 

USB pointing device is attached” check box.
4. Click OK to save the setting.

 Figure 2 - 8
Mouse Properties 

(Disable Touchpad) 
2 - 10 Touchpad and Buttons/Mouse
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the Touchpad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 9
Scrolling Gesture


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 10
Zooming Gesture
Touchpad and Buttons/Mouse 2 - 11
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the Touchpad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 11
Rotating Gesture

 Figure 2 - 12
Flick/Press 

Gesture
2 - 12 Touchpad and Buttons/Mouse
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar
notification area/control panel (right-click the taskbar notification area icon  to
bring up an audio menu). The volume may also be adjusted by means of the volume
icon in the taskbar or the audio slider in the Settings menu (see sidebar). 


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

 Figure 2 - 13
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
Audio Features 2 - 13
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Go to the Control Panel.
2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the 

taskbar icon  and select Sound Manager.
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 

Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

 Figure 2 - 14
Realtek Audio 

Manager - 
Recording Setup
2 - 14 Audio Features
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Shutting the Computer Down
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
8.1 OS.)

Power Options

Power management in
Windows is configured
from Power Options
(Hardware and
Sound), which can be
accessed from the Con-
trol Panel (see page 1 -
25).
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug 
the AC power cord into an outlet, and connect the AC power cord to the AC/DC 
adapter.

2. Raise the lid/LCD to a comfortable viewing angle.
3. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “Battery FAQ” on page 3 - 19).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 15.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.
3 - 2 The Power Sources



Power Management

3

Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.


Power Button as Stand by or Hibernate Button

You can use the OS’s “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).
Turning On the Computer 3 - 3
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Shutting the Computer Down
Note that you should always shut your computer down by choosing the Shut down
command as this will help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context Menu (right-click the lower left corner of the screen
to bring up the menu).

You can also use the Power Menu in Settings in the Windows 8.1 Charms Bar. If
you want to add Hibernate/Sleep to the Power Menu see “Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.

Figure 3 - 1
Shut Down/Restart

Charms Bar Desktop App Start Screen
3 - 4 Shutting the Computer Down
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 11 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 2
Power Plan 

Advanced Settings
Power Plans 3 - 5
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 3
Power Plans

Click to Show/Hide 
additional 
power plans
3 - 6 Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 8.1 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.


Wake On LAN 

Support 
(Windows 8)

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows 8.

If you require your com-
puter to wake up from
network activity in Win-
dows 8 then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
Power-Saving States 3 - 7
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hibernate to the
Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 4
Power Menu
3 - 8 Power-Saving States
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 5
Power Options 
Define Power 

Buttons
Configuring the Power Buttons 3 - 9



Power Management

3

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click “Change settings that are currently unavailable” .
3. Click Choose what the power buttons do.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options 
Define Power 

Buttons - Shutdown 
Settings
3 - 10 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Table 3 - 1
Resuming 

Operation


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 11
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Power Conservation Modes
This system supports Energy Star power management features (see over) that place
computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated
period of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.


Power Conservation 

Modes

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance. 

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure 3 - 7
Control Center
3 - 12 Configuring the Power Buttons
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Energy Star Notes

Display Mode Off
By factory default the Energy Star setting will put the display into sleep within 15 minutes of
user inactivity in order to reduce power consumption. The display will wake up upon sensing
a key press or mouse movement. To adjust this setting go to Power Options in the control
panel and click “Choose when to turn off the display”. Select an option from the drop-
down menu and then click Save Changes to apply the changes to the setting.

System Sleep Mode
To switch to System Sleep mode for this computer you can press the Fn + F4 key combi-
nation (or press Alt + F4 from the Desktop app in Windows 8, select Sleep from the drop-
down menu, and press OK). To wake the system from sleep press the power button.

Note: The default power management settings selected for compliance with Energy Star
have been recommended by the Energy Star program for optimal energy savings.

If the system is plugged-in Sleep will be activated after no more than 30 minutes (15 min-
utes if the system is battery powered) of user inactivity, by default in Windows.
Configuring the Power Buttons 3 - 13
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Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Win-
dows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log
off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

Figure 3 - 8
Ctrl + Alt + Delete 

Menu
3 - 14 Configuring the Power Buttons



Power Management

3

Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 3 on page 3 - 6).

Click the battery icon  in the notification area to see the current battery level and
charge status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 9
Battery Icon 

(Notification Area) & 
Battery Advanced 

Settings
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used (e.g. put the system in Airplane Mode).

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Windows Mobility 

Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 10
Windows Mobility 

Center
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 19 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. Refer to “LED Indica-
tors” on page 1 - 8 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 15 for more information on how to maintain and properly
recharge the battery pack.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 11
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 12
Change Plan 

Settings / Change 
Advanced Power 

Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 1%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 13
Power Options 

Advanced Settings - 
Battery
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and util-
ities necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 4
lists what you need to install and it is very important that the drivers are installed
in the order indicated.

Note that the information included on the following pages is for Windows 8.1 only.
For Windows 10 driver installation see “Windows 10 Drivers & Utilities” on page F
- 15.

Module Driver Installation
The procedures for installing drivers for the Wireless LAN, Fingerprint, Bluetooth
& WLAN Combo and Intel Technology modules are provided in “Modules & Op-
tions” on page 6 - 1.


Driver Installation & 

Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
What to Install 4 - 1
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Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1
4 - 2 Driver Installation
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order) 
which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 2 - Install Drivers
Driver Installation 4 - 3
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Table 4 - 1 - Driver Installation

All drivers provided are for the Windows 8.1 (64 bit) operating system.

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.

Win 8.1 (64 bit) Driver Page # Win 8.1 - Optional Items Page #

Chipset Page 4 - 7 PC Camera Module (No driver required for Windows 8.1) Page 7 - 3

Video (VGA) Page 4 - 7 Wireless LAN Module Page 7 - 12

LAN Page 4 - 7 Fingerprint Reader Module Page 7 - 18

CardReader Page 4 - 7 Bluetooth & WLAN Combo Module Page 7 - 21

Touchpad Page 4 - 7 Trusted Platform Module Page 7 - 26

Airplane Page 4 - 7
Intel Rapid Storage Technology (required for hard disks in 
AHCI/RAID mode)

Page 7 - 40

Hot Key Page 4 - 8 Intel® Rapid Start Technology Driver Page 7 - 47

MEI Driver Page 4 - 8 Intel® Smart Connect Technology Page 7 - 55

Audio Page 4 - 8 Intel® Small Business Advantage Page 7 - 60

3G/4G Module (No driver required for Windows 8.1) Page 7 - 74

Wireless Display (No driver required for Windows 8.1) Page 7 - 74
4 - 4 Driver Installation
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go to the Control Panel).
2. Double-click Device Manager (Hardware and 

Sound > Devices and Printers > Device 
Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
Driver Installation 4 - 5
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.
4 - 6 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install Drivers and Software > Next.
3. Click the button to accept the license and click 

Next.
4. Click Next > Install.
5. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install Airplane Mode AP > Yes. 
2. Click Next.
3. Click Finish to restart the computer.
Driver Installation 4 - 7
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Hot Key
1. Click 7.Install Hotkey AP > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

MEI Driver
1. Click 8.Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Audio
1. Click 9.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It is recommended you now also install the Intel Rap-
id Storage Technology driver (see “Intel Rapid Stor-
age Technology” on page 7 - 40 - required for AHCI
mode hard disks).


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security/

Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
4 - 8 Driver Installation
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Optional Drivers
See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Option Drivers

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.
Optional Drivers 4 - 9
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Setup Utility
Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot Logo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a “Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.
5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility 5 - 3
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
es to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.

Figure 5 - 1
Navigation Menu
5 - 4 The Setup Utility
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series / BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
5 - 6 Main Menu



BIOS Utilities

5

Advanced Menu

Figure 5 - 3
Advanced Menu
Advanced Menu 5 - 7
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Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to adjust the Bluetooth Power Setting and enable/
disable VT-d, Intel Virtualization Technology, Intel TXT(LT) Support, mSA-
TA/3G Slot Support and USB 3.0 port power/ Card Reader/ PCI Express Card
Power/ E-SATA Power.

VT-d (Advanced Menu > Advanced Chipset Control)
Enable/disable Intel® Virtualization Technology for Directed I/O (VT-d) from
this menu. This extends Intel's Virtualization Technology (VT) by providing hard-
ware assists for a virtualization solution.

Intel Virtualization Technology (Advanced Menu > Advanced Chipset Control)
Intel(R) Virtualization Technology enables a CPU to act as if it were several CPUs
working in parallel in order to allow several operating systems to run at the same
time in the same machine.

Intel TXT(LT) Trusted Execution Technology Support 
(Advanced Menu > Advanced Chipset Control)
Intel(R) Trusted Execution Technology may be enabled/disabled from this menu
item. TXT provides hardware and firmware security against software intended at-
tacks.
5 - 8 Advanced Menu
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mSATA/3G Slot Support 
(Advanced Menu > Advanced Chipset Control)
Select which device is installed in the mSATA/3G slot from this menu option. Select
the appropriate device installed in the slot from the menu, and then save the changed
BIOS settings. You will then need to shutdown the system and remove the AC/
DC adapter. You should then plug the AC/DC adapter back in again and restart the
computer to have the system recognize the changes made.


m/SATA/3G Slot 

Support

Note that 3G device will
only be available as a
selectable option if you
have included it in your
purchase configuration.

Figure 5 - 4
Advanced Chipset 

Control
(Advanced Menu)
Advanced Menu 5 - 9
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USB 3.0 Power/ Card Reader Power / PCI Express Card Power / 
E-SATA Power / (Advanced Menu > Advanced Chipset Control)
These menu items allow you to enable/disable power to the card reader, Express
Card or USB ports when required to do so in order to save power.

Intel Smart Connect Technology (Advanced Menu)
Smart Connect is a technology that makes checks on web applications that are open
even when the computer is in sleep mode, and thus allows updates to be made with-
out the need to turn the computer on. The sub-menus here allow you to enable/dis-
able the technology itself (ISCT Configuration). See “Intel® Smart Connect
Technology” on page 7 - 55 for configuration details. Note that Intel Smart Con-
nect Technology is not supported in the Windows 10 OS.

Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your
computer's state with zero power (see “Intel® Rapid Start Technology Driver” on
page 7 - 47). Note that Intel Rapid Start Technology is not supported in the
Windows 10 OS.


Powered USB Port

You may disable power
to the USB ports from
the menu option. How-
ever the powered USB
port (Figure 1 - 6 on
page 1 - 13) can still be
used to charge devices
as this function will not
be disabled here.

You can disable the
powered USB port’s
charge function by using
the Fn + power button
key combination toggle.
5 - 10 Advanced Menu
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SATA Mode (Advanced Menu)
The SATA (Serial ATA) controller operates in AHCI (Advanced Host Controller
Interface) mode. Install the Intel Rapid Storage Technology driver to support your
drive in AHCI mode (see “Intel Rapid Storage Technology” on page 7 - 40).

Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup. If you
disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options
prompts on the screen, however you can still press these keys, while the boot screen
is displayed, to perform the Enter Setup or Boot Option functions. If you have en-
abled UEFI Boot (see “UEFI Boot (Boot Menu)” on page 5 - 18) this option will
not be editable.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Advanced Menu 5 - 11
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility). If you set a supervisor
password you can then add a user password and password on boot.


Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 5
Security Menu
5 - 12 Security Menu
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Set User Password (Security Menu)
You can set a password for user mode access to the Aptio Setup Utility. This will
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode. You can only set the user password after you
have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Secure Boot Support (Security Menu)
Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot Support is available as a menu option if you
have enabled UEFI Boot (see “UEFI Boot (Boot Menu)” on page 5 - 18). En-
abling Secure Boot will bring up the Secure Boot Mode menu to enable you to con-
figure Secure Boot as Standard (with a fixed secure boot policy) or Custom (which
enables you to make changes to the Key Management database).


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to access the Security Device Support menu
and select Enable to display the full TPM configuration menu (see “Trusted Plat-
form Module” on page 7 - 96 for details).

Figure 5 - 6
TPM Configuration
5 - 14 Security Menu
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TPM State (Security Menu > TPM Support Enabled)
Select TPM State, press Enter and select Enable to change the TPM state to en-
abled. You will then need to press F4 to save the changes and restart the computer. 

As the computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.

Figure 5 - 7
TPM State (Enabled)
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Pending TPM operation (Security Menu > TPM Support & TPM State Enabled)
Select Pending operation, press Enter and select the option you require (if you are
initializing TPM you should select Enable Take Ownership). You will then need
to press F4 to save the changes and restart the computer.

Figure 5 - 8
Pending Operation 

(Enable Take 
Ownership)
5 - 16 Security Menu
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot Option Priorities. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 9
Boot Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
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Boot Option Priorities (Boot Menu)
Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.
5 - 18 Boot Menu
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Exit Menu

Click Save Changes and Reset to save all changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. You can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have made in
a previous session.

Figure 5 - 10
Exit Menu
Exit Menu 5 - 19
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Removing/Replacing the Component Bay Cover
• Upgrading the Optical (DVD) Device
• Upgrading the Hard Disk Drive
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .
5. Make sure the latch  is in the unlock position, and slide the battery into the bay 

until it locks into position. Make sure both locks are locked after the battery is in the 
bay.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal
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Removing/Replacing the Component Bay Cover
1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws  -  and lift the component bay cover up at point  to 

remove cover .
3. Replace the component bay cover by aligning the four cover pins with slots in the 

case to insure a proper cover fit before screwing down the bay cover.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 2
Component Bay 
Cover Removal
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Upgrading the Optical (DVD) Device
1. Turn off the computer, and turn it over and remove the battery and component bay 

cover (see page 6 - 4).
2. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
3. Reverse the process to install any new optical device.

Figure 6 - 3
Removing the DVD 

Device

1
2

1
2
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) / 7mm (h) (see “Storage” on page D - 3). Fol-
low your operating system’s installation instructions, and install all necessary driv-
ers and utilities (see “Driver Installation” on page 4 - 2), when setting up a new
hard disk.


HDD System 

Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the discs re-
quired to install your oper-
ating system and
programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.
6 - 6 Upgrading the Hard Disk Drive
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  & .
3. Remove the hard disk bay cover .
4. Raise the HDD assembly up at point  and then slide the assembly out by 

gripping the tab  and sliding the assembly out of the bay in the direction of the 
arrow.

Figure 6 - 4
Hard Disk Assembly 

Removal
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5. Remove the screw(s)  &  and the adhesive cover .
6. Reverse the process to install a new hard disk drive (do not forget to replace all the 

screws and covers).


Hard Disk Handling

Do not press down on
the center off the hard
disk as this area houses
the hard disk drive mo-
tor.

Figure 6 - 5
Hard Disk Cover 

Removal
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR3L type memory modules (see “Memory” on page D - 2 for details of
supported module types).

1. Turn off the computer, and turn it over and remove the battery and component bay 
cover (see page 6 - 4).

2. The memory (RAM) slots will be visible at point .

Figure 6 - 6
Memory (RAM) 

Location 

1

1
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3. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 7.

4. The RAM module will  pop-up, and you can remove it.

Figure 6 - 7
RAM Module 

Release Removal


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

2 3

4

4


Single Memory Module Installation

If your computer has a single memory module, then insert the module into the Channel 0
(JDIMM1) socket. In this case this is the lower memory socket (the socket closest to the
mainboard).

2

3

4
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5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

8. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

9. Replace the component bay cover (see “Removing/Replacing the Component 
Bay Cover” on page 6 - 4).

10. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.
Upgrading the System Memory (RAM) 6 - 11
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

Note that the information included on the following pages is for Windows 8.1 only.
For Windows 10 driver installation see “Windows 10 Drivers & Utilities” on page F
- 15.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use Fn + F11 Airplane
Mode key combination
to toggle Airplane Mode
On/Off, and check the
LED indicator for the
power status (see
Table 1 - 3, on page 1 -
10).

• PC Camera Module
• Wireless LAN Module
• Fingerprint Reader Module
• Bluetooth & WLAN Combo Module
• Trusted Platform Module
• Intel Rapid Storage Technology
• Intel® vPro™ Technology

• Intel® Rapid Start Technology 
Driver

• Intel® Smart Connect Technology
• Intel® Small Business Advantage
• 3G/4G Module
• Wireless Display
Overview 7 - 1



Modules & Options

7


Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
7 - 2 Overview
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PC Camera Module
When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated in red (see  Figure 1 - 2 on page 1 - 6). Note that you need to
use the Camera app in Windows to take pictures and capture video. Use the Fn +
F10 key combination (see “Function/Hot Key Indicators” on page 1 - 10) to tog-
gle power to the PC Camera module.

2
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PC Camera Audio Setup
If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Recording (tab).
3. Right-click hold and release Microphone (Realtek High Definition Audio) and 

make sure the item is not disabled.
4. Double-click Microphone (or select Properties from the right-click menu).
5. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
6. Click OK and close the control panels.

Figure 7 - 1
Audio Setup for PC 

Camera

Right-click
7 - 4 PC Camera Module
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Camera App
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. The camera interface will display two buttons on the right side of the screen.

3. The upper button  is used to record video, and the lower button  is used 
to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.
5. These buttons enable you to access the camera roll (where captured pictures and 

video are displayed), set the timer (the time period before capture begins; 3 
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain 
the best results.

Figure 7 - 2
Camera App 

Buttons


Exposure

Use the slider to adjust
the Exposure level.

Figure 7 - 3
Camera Options
PC Camera Module 7 - 5
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Camera Options
The Camera Options settings may be accessed as follows:

1. Run the Camera app from the Start screen by clicking on the Camera app icon 
.

2. While the camera app is running access the Charms Bar (e.g. click Use the 
Windows logo key  + C key combination).

3. Click Settings and then click Options.
4. You can adjust the Photo Aspect Ratio, Hide/Show grid lines and turn Location 

Info on or off from the Options panel.

Figure 7 - 4
Camera Options
7 - 6 PC Camera Module
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Taking Pictures/Capturing Video
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click the screen and select the timer if you require a countdown before 

capture.
3. Click the appropriate icon to take a picture or start video capture (if video capture 

begins a timer will appear in the bottom corner of the screen).
4. To stop video capture click the main window again (or click the stop icon ).
5. Captured photos and videos will be saved to a Camera Roll folder within the 

Pictures folder.

Figure 7 - 5
Pictures - Camera 

Roll
PC Camera Module 7 - 7
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Camera Roll
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.
4. Click the arrows  / (on either side of the screen) to browse through the 

captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

2. The Camera button will take you back to the home screen of the camera app.
3. Click Delete to remove any photo from the camera roll (you will be asked to click 

Delete again to confirm the deletion).
4. The Open With button will allow you to select a program with which to open the 

photo.
5. You can click Set as Lock screen to set the photo as the lock screen picture.
6. Clicking Slide Show will create a slide show of photos/video in the camera roll.
7. Click Rotate to rotate the picture through 90 degrees.
8. Use the handles to Crop any captured picture, and click Apply to make the 

changes (you can change the Aspect ratio by clicking the button and selecting an 
aspect ratio from the menu). You can Save a copy (create another copy of the 

Figure 7 - 6
Edit Buttons 

(for Still Photos)
7 - 8 PC Camera Module
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photo with the edited changes), Update original (which changes the original 
picture permanently) or Undo any changes.

9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to 

edit the photo as required.

11. After the editing process is completed right-click on the photo to Save a copy 
(create another copy of the photo with the edited changes), Update original 
(which changes the original picture permanently), Undo any changes or Cancel 
the editing.

Figure 7 - 7
Editing Tools

Basic Fixes Light Color EffectsEdit Menu
PC Camera Module 7 - 9
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Editing Videos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

2. Click Delete to remove any video from the camera roll (you will be asked to click 
Delete again to confirm the deletion).

3. The Open With button will allow you to select a program with which to run the 
Video.

4. Clicking Slide Show will create a slide show of photos/video in the camera roll.
5. Click Trim to edit the video. Use the round buttons at either end of the slider to 

adjust the video length and click Save a copy to save the changes made.

Figure 7 - 8
Edit Buttons 
(for Video)

Figure 7 - 9
Trim Video 

(for Video Files)
Click to select and move the rounded buttons to edit the video.
7 - 10 PC Camera Module
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Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video file to a
location other than the C: drive.
PC Camera Module 7 - 11
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option
make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver.

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use Fn + F11 Airplane
Mode key combination
to toggle Airplane Mode
On/Off, and check the
LED indicator for the
power status (see
Table 1 - 3, on page 1 -
10).
7 - 12 Wireless LAN Module
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3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 7 - 14).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click 

Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 7 - 14).
Wireless LAN Module 7 - 13
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WLAN Configuration in Windows
You can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the 

icon and Airplane mode should be Off).
3. A list of available access points will appear.

Figure 7 - 10
WiFi Settings 

(Charms Bar) & 
Networks
7 - 14 Wireless LAN Module
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4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. When you are connected to the network access point it will display Connected 

.
8. Select any connected network and click Disconnect  to disconnect from a 

connected access point.

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On 
or Off.

10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

Figure 7 - 11
Networks 

Connected / 
Disconnect
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Desktop Mode
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the wireless icon  in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 7 - 12
Windows Desktop 

Taskbar Notification 
Area WLAN 
Connection
7 - 16 Wireless LAN Module
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Security Modules (Fingerprint & TPM)
The encrypted channel between the Trusted Platform Module security chip (see
“Trusted Platform Module” on page 7 - 26) and the fingerprint reader (see “Fin-
gerprint Reader Module” on page 7 - 18) provides a high level of security for your
computer. A further level of security and control is provided in the BIOS (see “Se-
curity Menu” on page 5 - 12).

The fingerprint reader with the Protector Suite software allows you to:

• Access or Lock your computer
• Protect sensitive files
• Access frequently used websites using your fingerprint
• Fill in frequently log on information


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Modules (Fingerprint & TPM) 7 - 17
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Fingerprint Reader Module
The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive. 
2. Click Option Drivers.
3. Click 2.Install Fingerprint Driver > Yes.
4. Click Next > Install.
5. Click Finish to complete the installation.
6. The fingerprint reader module uses the Sign-in options configuration of the 

Windows Account (see overleaf).
7 - 18 Fingerprint Reader Module
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Fingerprint Module Configuration
1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Click Accounts and then click Sign-in options.
4. You will need to add a Windows password (click Add under Password).
5. After you have added the password you will need to restart the computer and use 

your password to log on to the system.
6. Go to the Charms Bar.
7. Select Settings and then click Change PC Settings.
8. Click Accounts and then click Sign-in options.
9. Click Add under Fingerprint.

Figure 7 - 13
Accounts - Sign-in 

Options 
(Add Fingerprint)
Fingerprint Module Configuration 7 - 19
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10. Input the Windows password and click OK.
11. You will then be instructed to swipe the same finger across the reader a number 

of times.

12. Click Finish.
13. You can choose to Add another finger (this is recommended) or Remove the 

current fingerprint reading.
14. You can now scan your fingerprint to log-on to the computer.

Figure 7 - 14
Add a Fingerprint
7 - 20 Fingerprint Module Configuration
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Use Fn + F11 Airplane
Mode key combination
to toggle Airplane Mode
On/Off, and check the
LED indicator for the
power status (see
Table 1 - 3, on page 1 -
10).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.
Bluetooth & WLAN Combo Module 7 - 21
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3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration in Windows” on page 7 - 23 for configura-

tion instructions.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Click Next > Finish.
7. See “Bluetooth Configuration in Windows” on page 7 - 23 for configura-

tion instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
7 - 22 Bluetooth & WLAN Combo Module
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Bluetooth Configuration in Windows
You can configure a Bluetooth connection as below, however make sure the Blue-
tooth module is on (or the system is not in Airplane Mode) before configuration.

Desktop Mode
1. Switch to the Windows Desktop (click the App or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon  (or

click and select Show Bluetooth Devices).
3. The Bluetooth item in PC and Devices will appear.

OR
Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Select the Bluetooth item in PC and Devices.


Bluetooth Headset 

Stereo Setup

To setup a Bluetooth
headset to support ste-
reo audio see page 8 -
15.

Figure 7 - 15
Bluetooth Taskbar 
Icon & Change PC 
Settings (Charms 

Bar -Settings)
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click Pair.

6. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

7. Enter the code into your Bluetooth enabled device and click Yes on the computer 
to complete the pairing.

8. Select a device and click Remove Device to disconnect from any device.

Figure 7 - 16
PC and Devices - 

Bluetooth

Figure 7 - 17
Enter the Passcode
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To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar, click the Bluetooth icon  and click

Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a check inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a check inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Figure 7 - 18
Bluetooth Settings
Bluetooth & WLAN Combo Module 7 - 25
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Trusted Platform Module
The TPM security chip allows you to create and manage digital certificates for user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features. 

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
a removable media (e.g. a USB flash drive) to store passwords etc. before begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
7 - 26 Trusted Platform Module
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Enabling & Activating TPM
1. Restart the computer.
2. Enter the Aptio Setup Utility pressing F2 during the POST/startup.
3. Use the arrow keys to select the Security menu
4. Select TPM Configuration and press Enter.
5. Select Security Device Support and press Enter, select Enable and press Enter.
6. Select TPM State, press Enter and select Enabled to change the TPM state to 

enabled. You will then need to press F4 to save the changes and restart the 
computer.

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM 
Configuration menu.

Figure 7 - 19
TPM State 
(Enabled)
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8. Select Pending operation, press Enter and select the option you require (if you 
are initializing TPM you should select Enable Take Ownership) and press Enter. 
You will then need to press F4 to save the changes and restart the computer.

9. You can now install the TPM driver (see “Trusted Platform Module (TPM) 
Driver Installation” on page 7 - 29) and then initialize the TPM.

Figure 7 - 20
Pending Operation 

(Enable Take 
Ownership)
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Trusted Platform Module (TPM) Driver Installation
1. Make sure you have enabled and activated the TPM in the BIOS before 

installing the driver.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
3. Click Option Drivers (button).
4. Click 4.Install TPM Driver > Yes.
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
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Initializing TPM
1. Switch to the Desktop app and click the TPM icon right-click the icon  in the 

notification area of the taskbar, and select Security Platform Initialization (or 
click the Security Platform State taskbar bubble).

2. Click User Settings (tab) and click Yes, or right-click the icon  in the 
notification area of the taskbar, and select Security Platform Initialization (or 
click the Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need 
to use advanced settings provided by your network administrator then select 
Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store 
passwords and data (keep the media in a safe place until required).

5. Select the drive you want to use from the drop-down menu and click Next.

Figure 7 - 21
Security Platform 
Quick Initialization 

Wizard
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6. Choose the Security Platform Features you want to use by clicking the 
appropriate check box.

7. Enter a Basic User Password (and re-type to confirm it) and click Next.

8. Click Next to confirm the settings.
9. The computer will then initialize the settings.
10. Click Finish.
11. Click the tabs and control panels to adjust the settings.
12. Double-click the icon  in the taskbar notification area to access the Infineon 

Security Platform Settings Tool, or right-click the icon  and select a menu 
item.


Help

Right-click the icon  in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific
help topics on each tab.

Figure 7 - 22
Settings
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,
your system administrator will need to assist you in managing the information here.


Menus

Note that not all the
menus pictured here will
be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details). 

Figure 7 - 23
Infineon Security 
Platform Settings 

Tool
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User Settings
This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

Figure 7 - 24
Infineon Security 
Platform Settings 

Tool (User Settings)
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Backup
Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-
tion.

Figure 7 - 25
Infineon Security 
Platform Settings 

Tool (Backup)
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure 7 - 26
Infineon Security 
Platform Settings 
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 7 - 27
Infineon Security 
Platform Settings 

Tool 
(Password Reset)
7 - 36 Trusted Platform Module



Modules & Options

7

BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitLocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure 7 - 28
Infineon Security 
Platform Settings 

Tool 
(BitLocker)
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure 7 - 29
BitLocker Drive 

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure 7 - 30
Infineon Security 
Platform Settings 

Tool 
(Advanced)
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Intel Rapid Storage Technology
Install the Intel Rapid Storage Technology to support your SATA drive if set up in
AHCI mode in the BIOS (see “SATA Mode (Advanced Menu)” on page 5 - 11).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install IRST Driver > Yes.
4. Click Next.
5. Click in the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the Apps screen.
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Intel® vPro™ Technology
Intel® vPro™ Technology is supported by Model B computers only. This set of
technology features, built into the computer’s motherboard, allows Information
Technology departments remote access to the computer. This allows the IT depart-
ment to monitor, maintain and manage computers regardless of the state of the op-
erating system or the computer’s power state. This can be done over a wired or
corporate wireless network, or even outside the corporate firewall through a wired
LAN connection. 

Accessing the Intel Management Engine
To access the Intel Management Engine press Ctrl + P at startup. Your system ad-
ministrator will need to assist you in managing the information as applicable to your
enterprise. Note the following password information for the Intel Management En-
gine:

• The default password is “admin” (without quotes).

If you get an "Error - Intel(R) ME password change rejected" message when cre-
ating a new password, then note the following parameters for creating a password:

• between 8 and 32 characters long 
• Contain both upper and lower case Latin characters 
• Have at least one numeric character 
• Have at least one ASCII non-alphanumeric character (!, @, #, $,%, ^, &, *)
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Select MEBx Login and press “Enter” to access the password screen. Enter the pass-
word “admin” (without quotes) and you will then be prompted to enter your own
password (note the password information on the previous page). Once you have en-
tered the password you will then be taken to the platform configuration screen.

The platform configuration screen allows you to setup Intel ME as per your require-
ments (consult your IT administrator for the actual settings required).

Figure 7 - 31
Intel(R) Management 

Engine
(Password Creation)
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Intel® Management and Security Status
(Model B Only)
Access the Intel® Management and Security Status control panels from app from
the Apps screen. These features allow users and IT Administrators to enhance and
protect computing assets. Your system administrator will need to assist you in man-
aging some of the information here.

Figure 7 - 32
Intel® Management 
& Security Status 

Help


User Guide

You can access the user guide pro-
vided to get help on any aspect of
the Intel® Management and Security
Status control panel.

Click on Learn More at the bottom
left of the control panel and then
click “For more information, refer
to the user guide” (link).

You will need to have the Adobe Ac-
robat Reader program installed (this
is provided on the Device Drivers &
Utilities + User’s Manual disc.
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General
The General tab provides basic information on the status of management and secu-
rity technologies provided by the Intel® Management Engine.

Figure 7 - 33
Intel® Management 
& Security Status 

General
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Intel® Small Business Technology
The Intel® SBT tab will be shown if you system is configured to support it. This al-
lows your network’s IT professionals to keep PCs up-to-date and protected.

Figure 7 - 34
Intel® Management 
& Security Status 

Intel® SBT
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Advanced 
The Advanced tab provides additional information on the system.

Figure 7 - 35
Intel® Management 
& Security Status 

Advanced

For Intel PRO Wireless 2200BG
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Intel® Rapid Start Technology Driver
Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Intel(R) Rapid 

Start Technology (Advanced Menu)” on page 5 - 10).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
• The Solid State Drive (not the HDD) must be configured as outlined on the fol-

lowing pages to support Rapid Start Technology.
• The Windows operating system must be installed on the system hard disk drive, 

and not on the Solid State Drive (SSD).

See overleaf for instructions on enabling Intel® Rapid Start Technology.


Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows
operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and
the SSD should be configured as outlined on the following pages. Rapid Start will not func-
tion if the operating system is installed on the SSD.
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Intel® Rapid Start Technology Configuration
1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) 

Rapid Start Technology (Advanced Menu)” on page 5 - 10).
2. Go the Windows control panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

Figure 7 - 36
Computer 

Management 
(Shrink SSD 

Volume)

Shrink Volume
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4. Enter the figure, which should be equal to amount of system memory (RAM) 
in your computer, in “Enter the amount of space to shrink in MB”.

5. Click Shrink (any unallocated file space may be formatted for storage use).

Figure 7 - 37
Shrink Volume 

Size


Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Run the Desktop app and right-click the lower left hot corner (or use the Windows 
Logo Key  + X key combination) and select Command Prompt (Admin).

7. Type “DISKPART”.
8. At the DISKPART command type “list disk”.

Figure 7 - 38
Search for CMD 

Prompt

Figure 7 - 39
Diskpart - List Disk
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9. Type “select disk #” (# is disk number where you want to create the store partition, 
so refer to the results obtained from "list disk" for exact disk number).

10. The message “Disk # is now the selected disk.” will appear.

11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should 

appear.

Figure 7 - 40
Diskpart - Select 

Disk #

Figure 7 - 41
Diskpart - Create 

Partition
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13. Type “detail disk”.

14. Type “select Volume #” (# is volume of your storage partition so refer to results 
obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.

Figure 7 - 42
Diskpart - Detail 

Disk

Figure 7 - 43
Diskpart - Select 

Volume #
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16. Type the following, depending on the format of the SSD.

• For MBR formatted SSDs: “set id=84 override” (the id must be set to 84).
• For GPT formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.

Figure 7 - 44
Diskpart - Set id=
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19. Go the Windows control panel and double-click Administrative Tools (System 
and Security)> Computer Management > Storage > Disk Management.

20. The disk partition should read Healthy Hibernation Partition.

21. Restart the computer.
22. Install the driver (see below).

Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 6.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Figure 7 - 45
Computer 

Management 
(Healthy 

Hibernation 
Partition) Healthy (Hibernation Partition)
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Intel® Smart Connect Technology
Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
without having to turn the computer on, and applications will be up to date when the
computer resumes from Sleep mode (make sure that Intel Smart Connect Technol-
ogy is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced
Menu)” on page 5 - 10).

Note that the applications need to be on and running when the computer enters
Sleep mode in order to get updates.

Intel® Smart Connect Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Make sure that Intel Smart Connect Technology is enabled in the BIOS - 

see “Intel Smart Connect Technology (Advanced Menu)” on page 5 - 10.
4. Click 7.Install ISCT Driver > Yes.
5. Click Next.
6. Click in the check box to accept the license and click Next.
7. Click Next > Install (OK) > Finish.
8. Click Yes to restart the computer.


Intel® Smart Connect 
Technology System 

Requirements

Note that in order to sup-
port Intel® Smart Con-
nect Technology your
system will need to have
the item enabled in the
BIOS (see page 5 - 10).

In addition only certain
Intel WLAN modules
support this feature.
Check with your distrib-
utor/supplier for de-
tails.
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Intel® Smart Connect Technology Configuration
1. Access the Intel(R) Smart Connect Technology application from the Apps menu.
2. Click the button to turn Keep Data Fresh ON.
3. You can select to have the system update open application data every 15, 30 or 

60 minutes.
4. Click Save to retain the settings (in order to update any applications, they will need 

to be on and running when the computer enters Sleep mode).
5. Note the sidebar warning about the use of Intel(R) Smart Connect Technology 

aboard aircraft and make sure your wireless LAN module is off during air travel.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 3,
on page 1 - 10).

Figure 7 - 46
iSCT Basic
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6. Click Customize Schedule to customize the update frequency, and the hours and 
days when the updates will occur.

7. Bear in mind that the more often you set the system to update, the more power is 
consumed, and this may be a consideration if the system is battery powered.


iSCT & System 

Power

Note that Intel Smart
Connect will turn off
when it detects a low
battery level, and will not
run if the system is Shut
Down or is in Hibernate
mode.

It is recommended that
the system be left
plugged-in if left for an
extended period.

Figure 7 - 47
iSCT Customize 

Schedule
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8. Click the Help icon and select Help to access the menu.


Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel’s
PROSet Wireless Con-
nection Utility in-
stalled), Intel® Smart
Connect Technology
will search for WiFi net-
works around you that
you have previously ac-
cessed. 

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure 7 - 48
iSCT Help
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Remote Wake
Remote Wake allows you to wake the computer remotely from another device such
as a phone, tablet or another PC. This will allow you to access files on the computer.

A link to a list of applications and usage is supplied if you click Learn More and
the link provided. An application must support this feature and you will need to reg-
ister any devices. Check any particular application for more information on this fea-
ture, and you will need to have the application loaded on any device from which you
want to connect to the system. A list of compatible applications is provided if you
click the link provided.
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Intel® Small Business Advantage
Intel® Small Business Advantage (Intel® SBA) is a hardware and software solu-
tion specifically designed for small businesses without a managed network or spe-
cialist IT professionals. Intel® SBA includes six applications which help manage
security and productivity.

Installing Intel® Small Business Advantage
Intel® SBA is installed from the Device Drivers & Utilities + User’s Manual disc,
but is not installed from the standard installation menus.

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 
drive.

2. Click Browse CD/DVD (button).
3. Navigate (Browse..) to D:\Drivers\Options\SBA\setup.exe and click OK.
4. Click Next > Next.
5. Click Finish to complete the installation process.

6. Intel® SBA can be run from the desktop shortcut  or from the App.
7. Click Configure to begin setting the application up to your requirements when 

first run.
8. Click in the check box and then click OK to accept the license terms.
9. You can choose to automatically check for updates or not, and then click OK.
10. You will then be required to input Password Settings, Send Email Settings and 

Export and Import Settings (click Save when the information is complete).


Password Settings

Make sure you input a
secure password for use
with Intel® SBA. The in-
dicator at the bottom of
the page will indicate the
strength of the pass-
word.
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SBA Application Modules
PC Health Center
This module allows you schedule automatic maintenance and hard disk defrag-
mentation, and to delete Temporary internet files and cookies. You can Schedule
these tasks to run at times most convenient for you e.g. in the middle of the night
when the computer is off. The hardware and software interaction allow SBA to
turn the computer on, and when the scheduled process is complete, turn it off
again.

Figure 7 - 49
PC Health Center
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Software Monitor
The Software Monitor detects programs running on your system designed to
protect your computer (e.g. Windows Defender, Microsoft Security Essentials
etc.). Should any malicious software code try to attack any of this important soft-
ware, the Software Monitor will pop up a warning.

Figure 7 - 50
Software Monitor
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USB Blocker
USB Blocker allows you to turn off types of mass storage (printers will still
function) in order to prevent data theft. You can choose to allow specific devices
(e,.g. your own flash drive) and prevent others from being used, or require a pass-
word for use.

Figure 7 - 51
USB Blocker
Intel® Small Business Advantage 7 - 63



Modules & Options

7

Data Backup and Restore
Data Backup and Restore will allow you to automatically backup your data at
regular intervals without having to interrupt your work to do so. The App will
use the Windows Backup Utility for a complete backup, and will take you
through the process to do so.

Figure 7 - 52
Data Backup and 

Restore
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Energy Saver
Energy Saver will help to shut down the computer, and start it up, at scheduled
intervals. This feature can be useful if you are in the habit of leaving the comput-
er on while away from work/home and letting it enter a power-saving state on its
own.

Figure 7 - 53
Energy Saver
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Help
For Help on Intel® SBA click the Help menu at the top right of the screen, and
click on any topic heading to get more information.


Intel® Smart 

Connect 
Technology 

You can also launch In-
tel® Smart Connect
Technology from the
Intel® SBA main window
(see “Intel® Smart
Connect Technology”
on page 7 - 55).

Figure 7 - 54
Help
7 - 66 Intel® Small Business Advantage



Modules & Options

7

3G/4G Module
If you have included an optional UMTS/HSPA+ based 3G Module (Universal Mo-
bile Telecommunications System or High Speed Packet Access) module or LTE
(Long Term Evolution) 4G module (see “Communication (All Models)” on page D
- 3 for specification details) in your purchase option, you do not require a driver/
application installation for Windows 8.1. Follow the instructions overleaf to install
the USIM card (which will be provided by your service provider), and then use the
Charms Bar Wireless icon to access the 3G/4G network in the same manner as
the WLAN (see page 7 - 69).


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 3,
on page 1 - 10).


Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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3G/4G Module USIM Card Installation
Follow the instructions below to install the USIM card (which will be provided by
your service provider).

1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .
5. Insert the USIM card  as illustrated below until it clicks fully into position, and 

replace the battery.


Power Safety 

Warning

Before you undertake any
installation procedures,
make sure that you have
turned off the power, and
disconnected all peripher-
als and cables (including
telephone lines).

USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.

Figure 7 - 55
Battery Removal & 

USIM Card Insertion

1
2

3
4

12

3

4
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3G/4G Configuration in Windows
You can configure a 3G/4G connection as below, however make sure the system is
not in Airplane Mode before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the 

icon and Airplane mode should be Off).
3. A list of available access points will appear under Mobile Broadband.

\

Figure 7 - 56 
Networks 

Mobile Broadband
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4. Any 3G/4G service provider (connection information is usually stored on the USIM 
card) will appear under Mobile Broadband.

5. Double-click any connection icon under Mobile Broadband (or click and then click 
Connect).

6. The system will connect to your network.
7. A Connected will appear alongside the 3G/4G connection (click the connection to 

view the timer which indicates your connected time for the current session).

Figure 7 - 57 
Mobile Broadband 

(Connect)
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8. You can then access the internet, download e-mail etc. as per any internet 
connection.

9. To disconnect you can select the connection and click Disconnect .

10. You need to either use Airplane Mode, or to turn the Mobile Broadband module 
off aboard aircraft.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited. 

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure 7 - 58
Mobile Broadband 

(Disconnect)
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EM820W 3G Module PIN Code & Power-Saving
Note that there may be some issues when a PIN Code is set for the EM820W 3G
module (if you are unsure of your module version contact your distributor/supplier)
in Windows, if Mobile Broadband has been turned off, and the system has resumed
from a power-saving state. To prevent any issues it is recommended that you sim-
ply do not enable a PIN for the EM820W 3G module. The following provides in-
structions for disabling the PIN code; for specific instructions on resolving the issue
where “Insert a SIM” appears in the connection see “Resolving the “Insert a SIM”
issue with the 3G Module (Windows 8.1)” on page 8 - 17.

Disabling a PIN code for a 3G Module
1. Go to the Charms Bar.
2. Click Change PC Settings.

Figure 7 - 59 
Change PC Settings
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3. Click Network.
4. Click the broadband connection under Mobile Broadband.
5. Scroll down to Security and click Remove PIN.
6. Enter the current PIN number and click OK.
7. It is recommended that you do not Enable a PIN for the EM820W 3G module.

Figure 7 - 60 
Disable PIN
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Wireless Display
Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make sure that your video adapter/display device is compatible with
your particular WLAN/Combo module) in conjunction with a compatible video
adapter/display device (purchased separately) to allow you to display the contents of
the notebook display on another display (e.g. HDTV), without the need to have ca-
bles stretching across a room.

You can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter using an HDMI or A/V ca-
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.


Compatible 
Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your distributor/
supplier.
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Wireless Display Configuration
1. Note that no driver or application is required for wireless display in Windows 8.1.
2. Go the Charms Bar, select Devices.
3. Click Project.
4. Click Add a wireless display.

Figure 7 - 61
Add a Wireless 

Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are 

connecting.
8. Click Next.

Figure 7 - 62
Searching For 

Devices

Figure 7 - 63
Enter PIN
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9. The display will then connect (for specific settings for your display see the 
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and 
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices) 
and click Disconnect.

Figure 7 - 64
Remove Device/

Disconnect
Wireless Display 7 - 77
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Indicators (see “LED Indicators” on page 1 - 7) to see 
the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or 
power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive.
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “The Setup Utility” on page 5 - 2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Shutting the Computer Down” on page 3 - 4) check its settings. You
may also be using a USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device is consuming a lot of power. Turn off/remove
the unused device to save power.
Problems and Possible Solutions 8 - 7
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 16). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Keyboard Shortcuts” on page 1 - 9) to adjust.

Unwelcome numbers appear when
typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 7).

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.


Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
Problems and Possible Solutions 8 - 9
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The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN or Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator  to see if it is in Airplane Mode (see “LED Indicators” on page 1 -
7). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table , on page 1 - 7).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Keyboard Shortcuts” on page 1 - 9). Run the camera
application to view the camera picture.

The Wireless LAN and Bluetooth
modules cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.

Problem Possible Cause - Solution
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The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

I am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. I have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

The USB port, card reader or ExpressCard
do not appear to be working.

The power to the USB port, card reader or ExpressCard has been disabled in
the BIOS. Go to the BIOS and enable the item.

Problem Possible Cause - Solution


USB Port / Card Reader / ExpressCard Power

Note that power to the USB ports, card reader and ExpressCard may be enabled/disabled in the BIOS (see page 5 - 10).
Problems and Possible Solutions 8 - 11



Troubleshooting

8

I have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go to the Programs and Features (Programs) control panel in 
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane 
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the 
current driver.

3. Restart the computer.
4. Insert the Device Drivers & Utilities + User’s Manual disc and click 

Install Drivers (button).
5. Double-click the Airplane Driver item in the menu.
6. Follow the instructions to install the correct driver (you will need to 

restart the computer as part of the installation process).

Problem Possible Cause - Solution
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I have connected a Bluetooth mouse but
it loses the Bluetooth connection and
no longer responds after a short period of
inactivity.

This is an issue with this mouse type and the Intel Wireless 7260 WLAN and
Bluetooth combo module series. To resolve this issue do the following:

1. Go to the Device Manager control panel in Windows.
2. Click the arrow alongside Bluetooth to expand the menu if required.
3. Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
4. Click the Power Management tab.
5. Make sure that the check box alongside “allow the computer to turn 

off this device to save power” doesn’t have a check alongside it.
6. Click OK and close the control panel.

Figure 8 - 1 - Device Manager (Bluetooth)

Problem Possible Cause - Solution
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When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

1. Go to the Devices & Printers control panel in Windows.
2. Double-click the Bluetooth headset.
3. Click Connect to complete the stereo connection.
OR
1. Go to the Sound control panel in Windows.
2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device 

(the default device is Headset).
3. Click Connect to complete the stereo connection.

Problem Possible Cause - Solution
8 - 14 Problems and Possible Solutions
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EM820W 3G Module PIN Code & Power-Saving
Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code.

Disabling a PIN code for a 3G Module
1. Go to the Charms Bar.
2. Click Change PC Settings.

Figure 8 - 2 - Change PC Settings
EM820W 3G Module PIN Code & Power-Saving 8 - 15
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3. Click Network.
4. Click the broadband connection under Mobile Broadband.
5. Scroll down to Security and click Remove PIN.
6. Enter the current PIN number and click OK.
7. It is recommended that you do not Enable a PIN for the EM820W 3G module.

Figure 8 - 3 - Disable PIN
8 - 16 EM820W 3G Module PIN Code & Power-Saving
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1)
1. If a PIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system 

in Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error 
may occur.

2. On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms 
Bar and turn on Mobile broadband.

3. Go to the Charms Bar.
4. Select Settings and you will then note that the WiFi icon will read Unavailable.
5. Standard procedure would be to click the connection and enter the PIN number to unlock the connection.
6. In this instance you will note that the Mobile broadband connection will read Insert a SIM. 
7. In this case you will need to restart the computer.
8. After system restart you can then connect to the Mobile Broadband as normal.
9. To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.
EM820W 3G Module PIN Code & Power-Saving 8 - 17
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.


USB Port / Card Reader / ExpressCard Power

Note that power to the USB ports, card reader and ExpressCard may be enabled/disabled in the BIOS (see page 5 - 10).
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

e-SATA Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out / S/PDIF 
Out Combo Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack. As a S/PDIF (Sony/Philips Digital Interface
Format) Out Port, this allows you to connect your DVD-capable PC to a Dolby AC-3 compatible
receiver for “5.1” or ‘dts’ surround sound.
A - 2 Interface (Ports & Jacks)
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Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports*/USB 
3.0 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

*Note: The powered USB 3.0 port (see “System Map: Right & Rear Views” on page 1 - 14)
may be toggled on /off by means of the Fn + Power Button key combination. When the powered
USB port is on it will supply power when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may
not work with certain devices - see page 8 - 11). Note: This function is designed to help charge
USB compliant devices, but is not designed to allow their operation.

Item Description

3.0

3.0
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Appendix B: Control Center
Overview
The following chapter will give a quick description of the functions of the Control Center. The Control Center
gives quick access to frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down
and move the dial control where applicable. Certain functions will automatically be adjusted when a power mode
is selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.

Figure B - 1 - Control Center


Control Center Access

To run the Control Center press the Fn + Esc key
combination, or double-click
the icon  in the notification
area of the taskbar. 

Close the Control Center by
clicking the  close icon in
the top right of the panel
(move the cursor onto the top
right corner of the panel to
highlight it).
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Power Modes
You can set a Power Mode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual icons in the
Control Center to power on/off the Touchpad and PC camera.

Table B - 1- Power Modes

Modes Quiet Power Saving Performance Entertainment

Icon

Power Plan Balanced Power Saver High Performance Balanced

Power Conservation Mode Balance Energy Star Performance Balance

PC Camera ON OFF ON ON

TouchPad ON ON ON ON

Airplane Mode OFF ON OFF OFF
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Control Center Menus
The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power
Modes. Click the menu headings and then click any of the buttons outlined on the following pages. 

Figure B - 2 - Control Center Menus
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Power Status (System Program)  / 

The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness (System Program) 
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. You can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)
You can set the fan speed to Maximum (full power) or Automatic from this menu item. The fan speed will
adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum if you
prefer.

Power Conservation (System Program)
This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into
a low-power sleep modes after a designated period of inactivity (see “Power Conservation Modes” on page 3 -
12). Click either the Performance, Balanced or Energy Star button.
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Sleep Button (System Program) 
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode when
the Fn + F4 key combination is pressed (see “Power-Saving States” on page 3 - 7).

Display Switch (System Program) 
Click the Display Switch button to access the menu (or use the  + P key combination) and select the appro-
priate attached display mode.

Time Zone (System Program) 
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background (System Program) 
Clicking the Desktop Background button will allow you to change the desktop background picture.

TouchPad/PC Camera (Device) 
Click either of these buttons to toggle the TouchPad or camera module’s power status. The icon will appear
dimmed when it is off. Note that the power status of the camera module is also effected by the Power Mode
selected (see Table B - 1, on page B - 2).

Docking  / 

Click the Docking (Enable/Disable) button to prepare the system for docking/undocking.
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Left Windows Key (Gaming) 
Click Disable to disable the Windows Key on the left side of the keyboard. This may be useful if you are using
the keyboard for gaming and wish to avoid accidentally triggering menus with the Windows Key.

Headphone (Gaming) 
The headphones may be set for different effects using this menu.

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.
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Appendix C: Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 30.

Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install 
Drivers (button).

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must be installed). DVMT returns whatever memory is no longer needed to the op-
erating system.


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Video Driver Installation C - 1
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Intel® HD Graphics Control Panel
Advanced video configuration options are provided by the Intel® HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Apps screen.

(see over)

Figure C - 1
Apps Screen

Intel® HD Graphics 

Control Panel
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OR
2. Right-click the Desktop and select Graphics Properties from the menu.
OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties

(button).
5. Double-click the Intel(R) HD Graphics control panel in the Windows Control

Panel. 

Figure C - 2
Intel® HD Graphics 

Control Panel
Intel® HD Graphics Control Panel C - 3
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You may make changes to any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings from the menus.

Figure C - 3
Intel® HD Graphics 

Control Panel
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Sub-Menus
Some of the menu panels will also have sub-menus (in the top left corner of the menu
alongside the icon ) to display further configuration options.

Figure C - 4
Intel® HD Graphics 

Control Panel

Sub-Menus
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Display
Click either Display Settings or Color to make display adjustments, including con-
figuration for any attached external displays.


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 5
Intel® HD Graphics 

Control Panel 

Display Settings
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Click the Display menu at the top of the screen to display the sub-menus. The Mul-
tiple Displays menu allows you to configure the display mode of any attached dis-
plays (see “Attaching Other Displays” on page C - 15).


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 6
Intel® HD Graphics 

Control Panel 

Display Settings - 

Multiple Displays
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3D
This menu allows you to choose how 3D images are displayed. Quality displays the
most detail, Balanced provides better computer performance with good quality and
Custom allows you to configure the Anisotropic Filtering and Vertical Sync fea-
tures to your preferences. Click Apply to save changes.

Figure C - 7
Intel® HD Graphics 

Control Panel 3D
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Options
Options allows you to Customize Hot Keys (for opening the application, rotating
the display, scaling etc.,) to your preferences. Click Apply to save changes.

Figure C - 8
Intel® HD Graphics 

Control Panel 

Options
Intel® HD Graphics Control Panel C - 9
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-In Display
and any attached displays.


Preferences 

Go to the Preferences
sub-menu in Options to
configure the preferenc-
es for the Intel® HD
Graphics Control Panel.

Make sure you turn Tray
Icon On to display the
Intel® HD Graphics
Control Panel icon in the
notification area of the
taskbar (as below).

Figure C - 9
Intel® HD Graphics 

Control Panel 

Options - 

Information Center
C - 10 Intel® HD Graphics Control Panel
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Video
The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. The Preview image will display a sample image using the current set-
tings. You can Save Profile and name the Profile to recall the settings at any time.
Click Apply to save changes (select Color Enhancement, Image Enhancement,
Image Scaling or Gamut Mapping from the menu).

Figure C - 10
Intel® HD Graphics 

Control Panel - 

Video (Color 

Enhancement)
Intel® HD Graphics Control Panel C - 11
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction etc.Click Apply to save changes.

Figure C - 11
Intel® HD Graphics 

Control Panel Video 

Image 

Enhancement Basic
C - 12 Intel® HD Graphics Control Panel
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The Image Scaling and Gamut Mapping menus allow you to adjust these items. 

Figure C - 12
Intel® HD Graphics 

Control Panel Video 

Image Scaling & 

Gamut Mapping
Intel® HD Graphics Control Panel C - 13
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Display Devices & Options
Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal monitor port. See your display device manual to see which formats are sup-
ported.

Display Mode Description

Single Display
One of the connected displays is used as the display device 
(PC screen only or Second screen only).

Clone/Duplicate
Both connected displays output the same view and may be 
configured independently

Extended / Extend 
Both connected displays are treated as separate devices, and 
act as a virtual desktop

Collage
A number of connected displays are combined into a 
single unified higher resolution for larger screen sizes 

Table C - 1
Display Modes


Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.
C - 14 Display Devices & Options
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Attaching Other Displays
To Clone Displays:
1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Clone from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. You can select the displays to be used from the Select Active Displays menu.


Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

Figure C - 13
 Display > Multiple 

Displays (Clone)
Attaching Other Displays C - 15
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To Enable Extended Mode:
1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Extended from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.


 Display Settings 

Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure C - 14 

Display > Multiple 

Displays (Extended)

Click the appropri-
ate monitor icon
and drag it to match
the physical ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).

Click Display Set-
tings to make any
adjustments re-
quired.
C - 16 Attaching Other Displays
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To Enable Collage Mode:
1. Attach your external displays to the external monitor port and HDMI-Out port, and turn 

them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Collage from the Select Multiple Display Mode menu.
4. Click Enable Collage and click On.
5. Click Vertical or Horizontal to arrange and displays as required.
6. Click Apply, and OK to confirm the settings change.


 Collage Mode 

Collage mode is used to
combine a number of
displays into a single
unified higher resolution
for larger screen sizes,.

Figure C - 15 

Display > Multiple 

Displays (Collage)
Attaching Other Displays C - 17
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Attaching Other Displays - Devices (Charms Bar)
You can configure attached displays from Devices (in the Charms Bar).

1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only,

Duplicate, Extend or Second screen only.


Windows Logo Key 

 + P Key 
Combination

You can use the  + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch  but-
ton in the Control Cen-
ter to access the menu
and select the appropri-
ate attached display
mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows.

Figure C - 16
Second Screen 

(Devices)
C - 18 Attaching Other Displays - Devices (Charms Bar)
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Configuring an External Display In Windows
1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel (see page 1 - 35) in the Desktop app.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure C - 17
Screen Resolution 

Multiple Displays
Attaching Other Displays - Devices (Charms Bar) C - 19
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure C - 18 

Screen Resolution 

Multiple Display 

Options
C - 20 Attaching Other Displays - Devices (Charms Bar)
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HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Playback (tab)
3. Depending on your display, the playback device may be selected, however in some 

cases you may need to select the audio device and click Set Default (button).
4. Double-click the device to access the control panel tabs illustrated overleaf.


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

Figure C - 19
Sound - HDMI 

Device (set Default)
HDMI Audio Configuration C - 21
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5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the Sound  control panel.

Figure C - 20
HDMI Device 

Properties
C - 22 HDMI Audio Configuration
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers 

you will need to go to the audio configuration control panel on the display and 
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other

Displays” on page C - 15.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


Other Applications

If you are using a third
party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult
the application’s docu-
mentation to see the
appropriate audio con-
figuration (the applica-
tion must support digital
to analog translation).
HDMI Audio Configuration C - 23
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Appendix D: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.
Specifications D - 1
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Processors

For All Models:
Intel® Core i7-4600M (2.9GHz)
Mobile Processor
4M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4330M (2.8GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4300M (2.6GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

For Model B Only:
Intel® Core i7-4702MQ (2.2GHz)
Mobile Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4200M (2.5GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

For Model B Only:
Intel® Core i3-4100M (2.5GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Core i3-4000M (2.4GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Pentium® 3550M (2.3GHz)
Mobile Processor
2M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Intel® Celeron® 2950M (2.0GHz)
Mobile Processor
2M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 37W

Core Logic

Model A:
Mobile Intel® QM87 Express Chipset

Model B:
Mobile Intel® HM87 Express Chipset

Display

15.6” / 39.62cm HD (1366 * 768) / HD+ 
(1366 * 768)  / FHD (1920 * 1080), 16:9 
Backlit Panel

Memory

Dual Channel DDR3L

Two 204 Pin SO-DIMM sockets 
supporting DDR3L 1600MHz (real 
operational frequency depends on the 
FSB of the processor)

Memory Expandable up to 16GB (using 
2GB / 4GB / 8GB SO-DIMM Modules)

Video

Intel® Integrated GPU (Intel® HD 
Graphics / Intel® HD Graphics 4600):
Dynamic Frequency
Intel® DVMT Shared Memory Architecture 
up to 1748MB
Microsoft DirectX®11 Compatible

BIOS

Two SPI Flash ROM - Total 96Mb
AMI BIOS
D - 2 Specifications
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Storage

One Changeable 2.5" / 9.5 mm (h) / 7mm 
(h) HDD with SATA (Serial) Interface

One Changeable 12.7 mm(h) Super Multi 
Optical Device Drive with SATA Interface 
(Factory Option)

mSATA SSD with SATA (Serial) Interface 
(Factory Option)

Audio

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Keyboard, Pointing Device & Buttons

Full Size Isolated Keyboard with Numeric 
Pad
Built-in Touchpad with Multi-Gesture and 
Scrolling Functionality

 Card Reader

Embedded Multi-In-1 Push-Push Card 
Reader

- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC
- MS/ MS Pro/ MS Duo
Note: Some of these cards require PC 
adapters usually supplied with the cards.

Slots

One ExpressCard™ (54/34) Slot

Two Mini-Card Slots:

Slot 1 for Half Size Mini-Card WLAN 
Module with PCIe & USB Interfaces

Slot 2 for Full Size Mini-Card 3G Module 
with USB Interface (Factory Option)
OR
for Full Size Mini-Card mSATA SSD 
Module with SATA Interface (Factory 
Option)

Interface

One USB 2.0 Ports
Three USB 3.0 Ports (Including 1 ACDC 
Powered USB Port)

Interface

One eSATA Port
One HDMI™ Out Port (with HDCP)
One External Monitor Port
One Audio Combo Jack (Headphone Out 
/ SPDIF Out Jack)
One Microphone-In Jack
One RJ-45 LAN Jack
One DC-In Jack
One Docking Port (with Hot Plug 
Functionality)

Communication (All Models)

UMTS/HSPDA  OR UMTS/HSPDA+ based 
3G Module with Mini-Card Interface 
(Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be 
used in North America

LTE 4G Module with USB Interface 
(Factory Option)

See over
Specifications D - 3
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Built-In Intel® 10/100/1000Mb Base-TX 
Ethernet LAN

1.0M HD Video Camera Module (Factory 
Option)

Communication (Model A Only)

Intel® Wireless-N 7260 (2*2 802.11 a/g/n)
Half Mini-Card PCIe WLAN + Bluetooth
Combo Module (Factory Option)

Intel® Wireless-N 7260 (2*2 802.11 a/g/n)
Half Mini-Card PCIe WLAN Module (Facto-
ry Option)

Communication (Model B Only)

Intel® Wireless-N 7260 (2*2 802.11 b/g/n)
Half Mini-Card PCIe WLAN + Bluetooth
Combo Module (Factory Option)

Intel® Wireless-N 3160 (1*1 802.11 b/g/n)
Half Mini-Card PCIe WLAN + Bluetooth
Combo Module (Factory Option)

3rd Party Combo WLAN (802.11b/g/n) 
and Bluetooth v4.0+LE Half Mini-Card 
Module with PCIe Interface (Factory 
Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module with PCIe Interface 
(Factory Option)

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Wake on RTC alarm (S5) by AC 
mode only

Power

Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 3.42A (65 Watts)

Removable 6 Cell Smart Lithium Ion Battery 
Pack 62.16WH

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module
Trusted Platform Module 1.2

For Model A Only:
Intel® vPro Support

LED Indicators

Power/Suspend, Battery, HDD/ODD, 
Airplane Mode, Num Lock, Caps Lock, 
Scroll Lock, Camera (on module)

Operating System

Windows® 8.1 (64-bit)

Design Features

All USB / e-SATA / Card Reader ports/
slots can be switched on/off in the BIOS
Touch Pad Slide Switch
Painted Style Finish
Intel® Rapid Start Technology
Intel® Small Business Advantage

For Model A Only:
Intel® Identity Protection Technology

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%
D - 4 Specifications



Specifications

D

Dimensions & Weight

374 mm(w) * 250 mm(d) * 35.5 mm(h)
2.33kg with Battery
Specifications D - 5
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Appendix E: Docking Station Guide

Overview
The docking station provides your computer with an easy connectable desktop environment when portability is
not required. This allows for easy connections to external displays, USB devices (with a full range of extra USB
ports), audio devices and provides a battery charging facility. 

Compatibility
Note that this docking station is compatible with particular computer models with the appropriate docking con-
nector only. Attempting to dock the computer to an incompatible docking system will result in an error message
(in this case immediately separate the computer from the docking station). Please contact your distributor/sup-
plier for full details.
Overview E - 1
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Computer and Docking Station
The computer may hot or cold dock/undock with the docking station, i.e. the computer may be powered on (hot
docking/undocking) or powered off (cold docking/undocking) when docking or undocking. However if you in-
tend to hot dock/undock the system then make sure that the hot key driver, provided on the computer’s Device
Drivers & Utilities + User’s Manual disc, is installed.

Docked System Power
The system power for a docked unit should be provided only by the docking station’s AC/DC adapter plugged
in to the DC-In jack at the rear of the docking station (make sure the computer’s AC/DC adapter is not used
at any time when the computer is docked). Follow the instructions on the next pages to safely dock and undock
your computer with the docking station.


Hot Docking/Hot Undocking & Power Saving Modes

If the computer is in a power-saving state (Sleep or Hibernate), or is resuming from a power saving state, do not attempt to
hot dock or hot undock the system.

Moving the Docking Station
Note that if the notebook is docked with the docking station, do not attempt to move the docked unit in order to avoid losing
connection. If you wish to move the docking station, then make sure you undock the notebook from the docking station before
doing so.
E - 2 Computer and Docking Station
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System Map: Front View Figure E - 1
System Map Front

1. Power Button LED
2. Backup Button (if a 

Hard Disk is 
installed in the 
Device Bay)

3. Lock Switch
4. Notebook Eject 

Latch
5. Notebook 

Placeholder
6. Retaining Pins
7. Docking Connector
8. Eject Pins

2 1

78

3

5

8


Backup Button

Note that when the backup button is used to backup the computer’s hard disk/files to the
docking station, in conjunction with the backup application, if a hard disk is installed in the
docking station’s bay.

4

6 6
System Map: Front View E - 3
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System Map: Rear ViewFigure E - 2
System Map Rear

1. Security Lock Slot
2. USB 3.0 Port
3. DVI-D Out Port
4. HDMI-Out Port
5. External Monitor 

Port
6. RS232 (Serial) 

COM Port
7. RJ-45 LAN Jack
8. DC-In Jack
9. Headphone Jack
10. Microphone Jack
11. S/PDIF-Out Jack
12. USB 2.0 Ports

1 3
11 12

2 4 5
9

6 7
10


LAN Jack & Docking

Note that when the computer is docked with the docking station, the notebook’s LAN Jack
can no longer be used as the network jack. When the system is docked use the docking sta-
tion’s LAN jack as the network jack.

8

1 2 3
4 5 6

7 8

11 129 10 12 12
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Power Button LED & Lock Switch LED Indicator

Table E - 1 - Power Button LED & Lock Switch LED Indicator

*To confirm the computer’s power status check the LED Power Indicators on the computer itself.

Icon Color Description

Orange DC Power is Plugged In and the Computer is Off or in Hibernate Mode*

Green The Docking Station is On or in Sleep Mode
Power Button LED & Lock Switch LED Indicator E - 5
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System Map: Left & Right ViewsFigure E - 3
System Map 

Left & Right Views

1. Bay with HDD or 
Dummy Caddy
OR

2. Bay with Optical 
Device Drive (DVD)

3. Powered USB 3.0 
Port

4. USB 3.0 Ports

1

2

3 4 4


USB Port Power

Note that power to the notebook computer and docking station’s USB ports may be enabled/
disabled in the notebook computer’s BIOS settings (see the BIOS guide in Chapter 5 of the
notebook’s user manual).
E - 6 System Map: Left & Right Views
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Cold Docking the Computer to the Docking Station
1. Remove all packing materials and place the docking station on a stable surface.
2. Securely attach any peripherals you want to use with the docking station (e.g. keyboard and mouse) to their 

ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the docking station, and then plug the AC power cord 

into an outlet, and connect the AC power cord to the AC/DC adapter.
4. The power button LED  on the docking station will be orange.

Figure E - 4 - Docking Station with AC/DC Adapter Plugged

1

1
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5. Make sure the computer’s hot key driver is installed (especially if you intend to hot dock the system).
6. Remove the AC/DC adapter from the notebook computer and then close the computer’s lid/LCD and turn it 

over.
7. Slide the notebook computer’s docking port cover latch in the direction of the arrow at point  to open the 

cover (failure to open the cover of the docking port before connecting the computer to the docking station may 
result in irreparable damage to the connector on the docking station).

Figure E - 5 - Opening the Docking Port

2


Docking Port Cover

Make sure you keep the cover closed when the computer is not docked in the station. This will
help prevent foreign objects and/or dust getting in to the contact area.

2
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8. Make sure that the notebook computer’s AC/DC adapter is NOT ATTACHED to the computer’s DC-In 
jack and that the computer is OFF.

9. Ensure that the lock switch on the docking station is in the unlock position.
10. Align the computer with the notebook placeholder  and then press the computer down onto the docking station.
11. Slide the lock switch on the docking station in to the lock position .
12. Press the power button  on the docking station (or power button on the notebook) to turn it on.
13. The Power LED on the docking station will be green and you can then use the docking station ports.

Figure E - 6 - Slide the Lock Switch

3
3

4

4


Moving the Docking Station

Note that if the notebook is docked with
the docking station, do not attempt to
move the docked unit in order to avoid
losing connection. If you wish to move
the docking station, then make sure you
undock the notebook from the docking
station before doing so.

AC/DC Adapter

Use only the docking station’s AC/DC
adapter plugged-in to the docking sta-
tion’s DC-In jack to power the computer.

5

3
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Cold Undocking the Computer from the Docking Station
1. Shut the computer down as per the normal Windows shutdown (select Shut Down from the Start menu in 

Windows 7) procedure (the Power LED on the docking station will be orange).
2. Slide the lock switch  on the docking station in to the unlock position.
3. Lift the eject latch  fully in the direction indicated to unlock the docking station, while carefully holding the 

notebook computer with one hand.
4. You can then lift the notebook computer off the docking station.
5. After disconnecting the computer from the docking station, slide the docking port cover latch  in the direction 

of the arrow.

Figure E - 7 - Slide the Switch to Unlock & Lift the Eject Latch

1

2

3

2

1

3
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Hot Docking the Computer to the Docking Station
1. Remove all packing materials and place the docking station on a stable surface.
2. Securely attach any peripherals you want to use with the docking station (e.g. keyboard and mouse) to their 

ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the docking station, and then plug the AC power cord 

into an outlet, and connect the AC power cord to the AC/DC adapter.
4. The power button LED  on the docking station will be orange.

Figure E - 8 - Docking Station with AC/DC Adapter Plugged

1

1
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5. Make sure the computer’s hot key driver is installed for hot docking/undocking the system.
6. The computer should be on, however remove the AC/DC adapter from the notebook computer and then close 

the computer’s lid/LCD and turn it over (if you are using the optional 9 cell battery you cannot hot dock the 
computer with the docking station).

7. Slide the notebook computer’s docking port cover latch in the direction of the arrow at point  to open the 
cover (failure to open the cover of the docking port before connecting the computer to the docking station may 
result in irreparable damage to the connector on the docking station).

Figure E - 9 - Opening the Docking Port

2


Docking Port Cover

Make sure you keep the cover closed when the computer is not docked in the station. This will
help prevent foreign objects and/or dust getting in to the contact area.

2
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8. Ensure that the lock switch on the docking station is in the unlock position.
9. Press the computer down onto the docking station so that the docking connectors line up (the Power LED on 

the docking station will be orange).
10. Slide the lock switch on the docking station in to the lock position .
11. The Power LED on the docking station will be green and you can then use the docking station ports.

Figure E - 10 - Slide the Lock Switch

3

3


Moving the Docking Station

Note that if the notebook is docked with
the docking station, do not attempt to
move the docked unit in order to avoid
losing connection. If you wish to move
the docking station, then make sure you
undock the notebook from the docking
station before doing so.

AC/DC Adapter

Use only the docking station’s AC/DC
adapter plugged-in to the docking sta-
tion’s DC-In jack to power the computer.
Hot Docking the Computer to the Docking Station E - 13
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Hot Undocking the Computer from the Docking Station
Hot undocking using Windows:
1. When the system is docked click the icon  in the taskbar notification area and click Safely Remove Hard-

ware and Eject Media  (Figure E - 11) from the menu.
2. Select Eject Docking Station  and the Undock Complete  message will appear in the notification area of 

the taskbar (the docking power LED will be Orange at this point and the ports, buttons and attached devices on 
the docking station will not work).

3. Follow steps 2 to 5 of the cold undocking procedure on page E - 10 to complete the undocking process. 

Figure E - 11 - Using the Windows System to Hot Undock the Computer

1
2 3

1 2

3


Battery Condition

Note that if you attempt to
hot undock the system
when the battery level is
low (default below 10%)
you will receive an error
message. In this case shut
the system down to cold
undock the notebook from
the docking station, or let
the battery charge suffi-
ciently until it is no longer
classed at a low level.
E - 14 Hot Undocking the Computer from the Docking Station
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Hot undocking using the Control Center:
1. Make sure the computer’s hot key driver is installed for hot docking/undocking the system.
2. Press the Fn + Esc key combination to run the Control Center. 
3. Click the Docking Enable button   in the Control Center (the icon displays the current docking status).
4. The docking icon will change to the Docking Disable  button to display the current status, and the Undock 

Complete  message will appear in the notification area of the taskbar (see over).

Figure E - 12 - Using the Control Center to Hot Undock the Computer

1

2

1

2


Battery Condition

Note that if you attempt to
hot undock the system
when the battery level is low
(default below 10%) you will
receive an error message.
In this case shut the system
down to cold undock the
notebook from the docking
station, or let the battery
charge sufficiently until it is
no longer classed at a low
level.
Hot Undocking the Computer from the Docking Station E - 15
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5. Press the Fn + Esc key combination to run the Control Center.
6.  The docking power LED will be Orange at this point and the ports, buttons and attached devices on the 

docking station will not work.
7. If you do not wish to separate the notebook and docking station at this point you can click the docking icon in the 

Control Center to re-dock the system.
8. Follow steps 2 to 5 of the cold undocking procedure on page E - 10 to complete the undocking process.
E - 16 Hot Undocking the Computer from the Docking Station



Docking Station Guide

D
o

ckin
g

 S
tatio

n

Power Button Configuration
To prevent your computer from entering a power-saving state if you choose to work with the lid/LCD closed,
then it may be necessary to redefine what the computer is set to do if the lid/LCD is closed when plugged in.

1. Go to the click Power Options (Hardware and Sound) control panel.
2. Click Choose what closing the lid does (in the left pane).
3. Set the When I close the lid: option when the computer is plugged in to Do nothing.
4. Click Save Changes and close the control panel.

Figure E - 13 - Power Options (Choose what closing the lid does)


Hot Docking/Hot Undocking 

& Power Saving Modes
If the computer is in a power-sav-
ing state (Sleep or Hibernate), or is
resuming from a power saving
state, do not attempt to hot dock or
hot undock the system.
Power Button Configuration E - 17
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Docking Station Ports & Jacks
The following will give a quick description of the interface (ports & jacks) which allow your docking station and
computer to communicate with external devices, connect to the internet etc. When the notebook is docked to the
docking station all the ports on the docking station will function, however only some of the ports on the notebook
will function (see the note alongside each item for specific information.

Item Description Note

COM/RS232 Serial Port The COM/serial is a communication interface for data transfer,
through which information transfers in or out one bit at a time.
This port can be used to connect the computer to devices such
as terminals and peripherals.

This port is supported in the
Windows environment and
at the DOS prompt, however
there is no COM mouse
support.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your
docking statio and docked computer.

Use only the docking
station’s AC/DC adapter
plugged-in to the docking
station’s DC-In jack to power
the computer.

DVI-D Out Port The DVI-D Out (Digital Visual Interface-Digital) Port is a video
connector interface supporting digital displays only. This allows
you to connect an external monitor, TV or Flat Panel Display etc.
as a display device by means of a DVI-D compatible cable.
E - 18 Docking Station Ports & Jacks
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External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel
Display, to get dual video or simultaneous display on the LCD
and external monitor/FPD.

Use only the external monitor
port on the docking station
when the system is docked.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an
audio/video connector interface for transmitting uncompressed
digital streams. This allows you to connect an external monitor,
TV or Flat Panel Display etc. as a display device by means of a
HDMI cable. Note that HDMI carries both audio and video
signals.

You can use the HDMI ports
on both the docking station
and the notebook, connected
to two separate displays,
when the system is docked.

Headphone-Out Jack Headphones or speakers may be connected through this jack.
Note: Set your system’s volume to a reduced level before
connecting to this jack.

You can use the headphone
and microphone jacks on
either the computer and/or
docking station when the
system is docked.Microphone-In Jack Plug an external microphone in to this jack to record on your

computer.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the
LAN port.

Note that when the system is
docked the notebook’s LAN
Jack can no longer be used
and you must use the
docking station’s LAN jack as
the network jack only.

Item Description Note
Docking Station Ports & Jacks E - 19
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Security Lock Slot To prevent possible theft, a Kensington-type lock can be
attached to this slot. Locks can be purchased at any computer
store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port
allows you to connect your DVD-capable PC to a Dolby AC-3
compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports*

USB 3.0 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1
compliant) are for low-speed peripherals such as keyboards,
mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged
from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0
ports are colored black. USB 3.0 will transfer data much faster
than USB 2.0, and is backwards-compatible with USB 2.0.

Note: The powered USB 3.0 port function is designed to help
charge USB compliant devices, but is not designed to allow
their operation.

You can use the ports on both
the computer and the docking
station when the system is
docked.

*Note: The powered USB
3.0 port (see  Figure E - 3
on page E - 6) will supply
power when the docking sta-
tion is powered by the AC/DC
adapter plugged into a work-
ing outlet, (this may not work
with certain devices). The
notebook does not need to be
docked for this to function.
There is no LED to indicate a
charge status on the docking
station.

Item Description Note

3.0
3

E - 20 Docking Station Ports & Jacks



Docking Station Guide

D
o

ckin
g

 S
tatio

n

Multiple Displays
Any two of the following displays may be enabled simultaneously when the system is docked. You can toggle
through the display options by using the Fn + F7 key combination (make sure any attached displays are powered
on).

1. The notebook’s LCD panel
2. An external display attached to the notebook’s HDMI port.
3. An external display attached to the docking station’s external monitor (VGA) port.
4. An external display attached to the docking station’s DVI-D port.
5. An external display attached to the docking station’s HDMI port.

BIOS Controls - USB ports, Card Reader & ExpressCard
Note that power to the notebook computer’s USB ports, card reader and ExpressCard may be enabled/dis-
abled in the notebook computer’s BIOS settings (see the BIOS guide in Chapter 5 of the notebook’s user man-
ual). The USB 3.0 Power item and Powered USB 2.0 Port Power settings in the BIOS will also affect the power
supplied to the docking station’s 4 * USB 3.0 ports and 3 * USB ports respectively.

The notebook’s card reader and ExpressCard will continue to function when the system is docked as long as
they are not disabled in the BIOS. 
Docking Station Ports & Jacks E - 21
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One Button Hard Disk Backup
When the system is docked you can press the Hard Disk Backup Button (  Figure E - 14) to launch Win-
dows 8’s Recovery application. If you do not have a hard disk installed in the docking station you can set the
application to backup files or a system image to any attached hard disk, CD/DVD or non system partition of your
computer. 

Figure E - 14 - Front View (HDD Backup Button)

1

1

E - 22 One Button Hard Disk Backup
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Backup Procedure
You can choose to backup individual files and folders or alternatively create a System Image Backup.

1. Press the hard disk backup button.
2. Windows Recovery application will be launched.
3. Click File History.
4. If you are on the first run of the program click Turn On.

Figure E - 15 - Windows 8 File History (Turn On)
Backup Procedure E - 23
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5. You can click Select drive (see Figure E - 15 on page E - 23) and select the drive (e.g the drive installed on the 
docking station) to backup the system image, or libraries, desktop, contacts and favorites (see below) to 
(you can also choose to backup to a network location).

6. Click OK.

Figure E - 16 - Select Drive
E - 24 Backup Procedure
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System Image Backup
Follow the instructions on these pages to perform a a full system image backup (if you want to backup individual
files and folders see Figure  on page E - 29.

1. Click System Image Backup from the File History control panel (see Figure E - 15 on page E - 23.
2. Select where you would like to save the backup (e.g the drive installed on the docking station) and click Next.
3. Select which drives you want to include in the system backup by clicking to put a check in the check box 

alongside any drives and click Next.

Figure E - 17 - Create a System Image
Backup Procedure E - 25
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4. Click Start backup to begin the backup procedure (for a large amount of data this could take some time).
5. Windows will then begin the backup procedure.
6. You system backup will now be stored on the selected location and you can use it as part of the recovery 

process if required.

Figure E - 18 - System Image Backup
E - 26 Backup Procedure



Docking Station Guide

D
o

ckin
g

 S
tatio

n

System Image Recovery
You can recover your backed up system image by using Update and recovery application in PC Settings.

1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Click Update and Recovery, and then click Recovery.
4. Click Restart now under Advanced startup and the computer will restart to begin the recovery process.

Figure E - 19 - PC Settings - Update and Recovery
Backup Procedure E - 27
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5. Click Troubleshoot.and then click Advanced Options.
6. Click System Image Recovery.

Figure E - 20 - Troubleshoot / advanced Options

7. The system will the prepare to recover the system image.
8. You will be asked to select your account by clicking on the account name.
9. Input the system password when prompted and click Continue.
10. The system will then re-image the computer.
11. You should then either choose the latest available backup if required, or browse to the image stored on the 

docking station by clicking in Select a system image and clicking Next to go to the image of the backup 
required.

12. Click to select the image required and click Next.
13. You can then choose any additional restore options required and click Next.
14. Click Finish > Yes to start restoring the data.
15. Click Restart Now to complete the procedure.
E - 28 Backup Procedure
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File History Backup
1. You can click Select drive to select a drive to backup the libraries, desktop, contacts and favorites (see 

below) to by clicking select drive (you can also choose to backup to a network location).

Figure E - 21 - Select Drive (Backup Location)


Windows 8 File History Backup

Windows 8 File History does not allow the
creation of full system images, and does not
allow you to back up everything on the hard
disk drive. 

Windows 8 File History allows you to back-
up files in libraries, desktop files, contacts
and favorites. You can add folders to librar-
ies to include in a backup, and you can ex-
clude certain library files from being backed
up, but you cannot include files from out-
side the libraries or desktop. 

This is designed to work more efficiently, and
to be less cumbersome, in protecting a us-
er’s essential personal files and not the sys-
tem files, OS and applications which can
easily be reinstalled.
Backup Procedure E - 29
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2. Click Exclude folders and then click Add to select any folders you do not want to back up as part of the 
process, then click Save changes to confirm.

Figure E - 22 - Exclude Folders
E - 30 Backup Procedure
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3. Click Advanced settings:

• Save copies of files: Set the interval of the backup (in Windows 8 the default is a continuous backup that 
takes a snapshot of the files every hour).

• Size of offline cache: Set the amount of disk space to be reserved for the backup files. 
• Keep saved versions: Set how long saved versions are to be kept for.
• Create or join a homegroup: You can advertise your backup drive as a backup drive for your homegroup to 

allow all Windows computers in your homegroup to back up files to this centralized backup location.

Figure E - 23 - Advanced Settings
Backup Procedure E - 31
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4. Click Run now to begin the backup process (you can click Stop at any time if you need to cancel the backup 
process).

Figure E - 24 - Run Now
E - 32 Backup Procedure
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Restoring Files from File History Backup
1. Press the hard disk backup button.
2. Windows 8’s File History application will be launched.
3. Click “Restore personal files”.

Figure E - 25 - Restore Personal Files
Backup Procedure E - 33
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4. The most recent backup will appear in the Home - File History window (you can click the arrows to scroll 
through the different backup date files if they are retained).

5. Click the button  to restore the whole backup to the original location.

Figure E - 26 - Home File History 
E - 34 Backup Procedure
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6. If the files are being restored to their original location then you will be asked if you want to replace files, skip files 
or decide for each file.

7. You can decide which file to keep, or select both to add a file with a number added as a suffix.

Figure E - 27 - Replace or Skip Files/File Conflicts
Backup Procedure E - 35
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8. You can also browse the individual backed up folders to select files.
9. Right-click an individual file and select Restore to, to select a location of your choice to restore the file. 

Figure E - 28 - Right-Click File Menu
E - 36 Backup Procedure
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Specifications
Storage

One Changeable 12.7mm(H) Super Multi ODD / Blu-ray Combo 
ODD or 2.5" / 9.5 mm(H) HDD Caddy with SATA (Serial) 
Interface (Factory Option)

Interface and Ports

Three USB 2.0 Ports
Four USB 3.0 Ports (including 1 * powered USB port)
One External Monitor Port
One DVI-D Out Port
One HDMI™ Out Port (with HDCP)
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One RJ-45 LAN Jack
One RS232 (Serial) COM Port
One Docking Port (Hot Plug)
One DC-In Jack

Buttons & Switches

Power Button, Notebook Eject Latch, Docking Lock Switch &
HDD Backup Button

Power

Full Range AC/DC 90W Adapter
AC input 100 - 240V, 50 - 60Hz, DC Output 19V, 4.74A

Security

Security (Kensington® Type) Lock Slot

LED Indicators

Adapter Power/System
System Operation Indicator

Environmental Spec

Temperature 
Operating:   5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

380mm (w) * 206mm (d) * 33mm (h)
0.85kg
Specifications E - 37



Docking Station Guide

D
o

ckin
g

 S
tatio

n

E - 38



Windows 10

W
in

d
o

w
s 1
Appendix F: Windows 10

Overview
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 10 OS.

You can refer to the main manual for details of audio & video information, BIOS, modules etc. However drivers
information specific to Windows 10 will be included in this Appendix, as well as details on how to navigate the
Windows 10 user interface to access the applications, control panels, taskbar etc. Note that Windows 10 will be
subject to constant updates and revisions, and some of the screens pictured throughout this chapter may change
over the course of time and appear differently from those illustrated.


Windows 10 OS

In order to run Windows 10 (64 bit) your computer requires a minimum 2GB of system memory (RAM).
Overview F - 1
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Windows 10 Start Menu
Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking the icon  in the taskbar in the lower left corner of the screen (or by pressing the Windows
Logo Key  on the keyboard).

Figure F - 1 - Windows Start Menu

Desktop
F - 2 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu
Right-click the Start Menu  icon (or use the Windows Logo Key  + X key combination) to bring up an
advanced Context Menu of useful features such as Control Panel, Programs and Features, Power Options, Task
Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Figure F - 2 - Right-Click Windows Logo in Start Menu

Right-Click Icon
Windows 10 Start Menu F - 3
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Start Menu Apps & Tiles
The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Figure F - 3 - Expanding the Start Menu
F - 4 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu
To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on a program’s icon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. You can use the same method to pin apps/pro-
grams to/from the taskbar (select pin to taskbar/unpin this program from the taskbar). 

Figure F - 4 - Pin to Start/Unpin from Start
Windows 10 Start Menu F - 5
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Windows 10 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 10.

Figure F - 5 - Windows 10 Control Panel Access

• Right-click the Start Menu icon 
 in the taskbar in the lower left 

corner of the screen and select 
Control Panel from the menu. 

• Press the Windows logo key  
on your keyboard and X to bring 
up the context menu, and then 
press P to bring up the Control 
Panel.

• Type Control Panel into the 
Search box in the taskbar and 
click on the icon when it pops up.
F - 6 Windows 10 Control Panel
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Settings
The Settings item in the Start Menu (and also as an App) gives you quick access to a number of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Ac-
counts, Time & language, Ease of Access, Privacy and Update & security.

Figure F - 6 - Settings
Windows 10 Control Panel F - 7
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Windows 10 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Figure F - 7 - Taskbar

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Pining/
Unpinning Apps & Programs to/from the Start Menu” on page F - 5).

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
F - 8 Windows 10 Control Panel
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearance
and Personalization). Click Adjust resolution to make changes to the appearance of the display and to detect
and configure any attached displays. In Windows 10 it is possible to quickly configure external displays from
the Project menu (press the Windows logo key  on your keyboard and the P key).

To Configure Displays using Project

Figure F - 8 - Project

1. Attach your display to the appropriate 
port, and turn it on.

2. Press the  + P key combination.
3. Click on any one of the options from

the menu to select PC screen only,
Duplicate, Extend or Second
screen only.

4. You can also click Connect to a
wireless display at the bottom of the
Project screen and follow the steps
to connect to any wireless enabled
display.
Video Features F - 9
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To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Make and changes required from the Display, Resolution, Orientation or Multiple display menus.
4. Click Apply to save the settings.

Figure F - 9 - Screen Resolution

2

1


Screen Resolution

1. Use the dropbox to select 
the screen Resolution  
(Figure F - 9).

2. Click Advanced settings 
 (Figure F - 9) to bring up 

the Advanced properties 
tabs.

3. Click Apply to save any 
changes made.

1

2
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Display Settings:
1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings .
2. Adjust the settings using the sliders in the menu or click Advanced display settings  to change resolution.
3. Click Apply to save any changes made to resolution.

Figure F - 10 - Display Settings

1
2

2

1

Video Features F - 11
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can also add Hibernate/Sleep to
the menu - see page F - 13). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Figure F - 11 - Shut Down/Restart 

Using the Power Button
1. Go to the Start Menu.
2. Click the Power button .
3. Select the power state required

from the menu.
F - 12 Power Options
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You can also use the context menu (right-click the Start Menu  icon or press the Windows logo  + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

Figure F - 12 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination to bring up a full-screen displaying Lock, Sign out,
Change a password, Task Manager and Switch User. If you click the Power icon in the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.


Adding Hibernate/Sleep to the Power Men

1. Go to the Power Options (Hardware and Sound) 
control panel.

2. Click Choose what the power buttons do.
3. Click “Change settings that are currently 

unavailable” .
4. Click to put a check in the Hibernate/Sleep box 

under Shutdown settings.
5. Click Save Changes and close the control panel.
Power Options F - 13
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Minimum Screen Resolution Settings
1. Windows 10 has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select Screen Resolution (or go to the Display control panel).
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

Figure F - 13 - Screen Resolution
F - 14 Power Options
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Windows 10 Drivers & Utilities
Make sure you install all the drivers and utilities for your Windows 10 system as outlined in the following pages.

Driver Installation (Windows 10)
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive, or an attached DVD 

drive if applicable.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.
5. Check the driver installation order from Table F - 1, on page F - 16 (the drivers must be installed in this 

order) which is the same as that listed in the Drivers Installer menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.


Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User’s Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key  + E key combina-
tion to go to Computer in Windows Explorer).
Windows 10 Drivers & Utilities F - 15
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Table F - 1 - Driver Installation

Windows 10 (64-bit) Drivers

 Chipset Page F - 17  Wireless LAN Module Page F - 19

 Video (VGA) Page F - 17  Fingerprint Reader Module Page F - 21

 LAN Page F - 17  Bluetooth & WLAN Combo Module Page F - 23

 CardReader Page F - 17  Intel® Rapid Storage Technology Page F - 26

 Touchpad Page F - 17  PC Camera (No driver required) Page F - 27

 Airplane Page F - 18  Trusted Platform Module (No driver required) Page F - 28

 Control Center Page F - 18  3G/4G Module (No driver required) Page F - 29

 MEI Driver Page F - 18

 Audio Page F - 18
F - 16 Windows 10 Drivers & Utilities
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Accept > Install.
3. Click Restart Now to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
eo settings to the highest resolution.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install Drivers and Software > Next.
3. Click the button to accept the license and click 

Next.
4. Click Next > Install.
5. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.
Windows 10 Drivers & Utilities F - 17
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Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install Airplane Driver > Yes. 
2. Click Next > Install.
3. Click Finish to restart the computer.

Control Center
1. Click 7.Install Control Center AP > Yes. 
2. Click Next > Install.
3. Click Finish to restart the computer.

MEI Driver
1. Click 8.Install MEI Driver > Yes.
2. Click Next.
3. Click the check box to accept the license and 

then click Next.
4. Click Next.
5. Click Finish.

Audio
1. Click 9.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

Optional Drivers
See the following pages for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Note that you need to install both the WLAN & Blue-
tooth drivers for the WLAN & Bluetooth Combo
modules.
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option make sure that the module
is on (i.e. the system is not in Airplane Mode) before installing the driver. Make sure you install the drivers in
the order indicated in Table F - 1, on page F - 16.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.


Wireless Device 

Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited. 

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.
Wireless LAN Module F - 19
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3rd Party WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).
F - 20 Wireless LAN Module
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Fingerprint Reader Module
The fingerprint reader module provides a high level of security for your computer. Make sure you have admin-
istrator’s rights to your computer, and have a Windows password enabled for full security protection.

The fingerprint reader module uses the Sign-in options configuration of the Windows Account.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers.
3. Click 2.Install Fingerprint Driver > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. The fingerprint reader module uses the Sign-in options configuration of the Windows Account (see 

overleaf).


Fingerprint Reader and Power Saving States

If your computer is in a power saving state (e.g. Hibernate or Sleep) you should keep your finger clear of the fingerprint
sensor.

Allow the system to fully resume before swiping your finger across the sensor.
Fingerprint Reader Module F - 21
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Fingerprint Module Configuration
1. Click the Settings item in the Start Menu and then click Accounts and click Sign-in options.
2. You will need to add a Windows password (click Add under Password).
3. After you have added the password you will need to also add a PIN.
4. Under Windows Hello click Set up under Fingerprint.
5. The wizard will then guide you through the set up process to scan your fingerprints.
6. You will be instructed to swipe the same finger across the reader a number of times.
7. Click Close when complete.
8. You can choose to Add another finger (this is recommended) or Remove the current fingerprint reading.
9. You can now scan your fingerprint to log-on to the computer.

Figure F - 14 - Accounts - Sign-in options (Add Fingerprint)
F - 22 Fingerprint Reader Module
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver as instructed overleaf (two drivers are provided for the 3rd party WLAN module and
one for the Intel WLAN module). Make sure you install the drivers in the order indicated in Table F - 1, on
page F - 16.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.


Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module is either OFF or in Airplane mode if you are using the computer
aboard aircraft.
Bluetooth & WLAN Combo Module F - 23
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3rd Party Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 3.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration” on page F - 25 for instructions on configuring Bluetooth connections.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 3.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Select the setup type (Typical is recommended) and click Install.
7. Click Finish.
8. See “Bluetooth Configuration” on page F - 25 for instructions on configuring Bluetooth connections.
F - 24 Bluetooth & WLAN Combo Module
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Bluetooth Configuration
1. Click the Settings item in the Start Menu and then click Devices.
2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices will appear.
3. Double-click the device you want to pair with the computer and click Pair.
4. On first connection the computer will provide you with a pairing code to be entered onto the device.
5. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
6. Select a device and click Remove Device to disconnect from any device.
7. Click More Bluetooth Options, and make sure that Allow Bluetooth devices to find this computer check 

box (Discovery) has a check inside it.
8. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has 

a check inside it, if you want to be notified when a Bluetooth device wants to connect.
Bluetooth & WLAN Combo Module F - 25
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI mode SATA drive.

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install IRST Driver > Yes.
4. Click Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the All Apps screen (in the Start Menu).


IRST and M.2 PCI-e SSDs

Note that Intel® Rapid Storage Technology does not support M.2 SSDs with a PCI-e In-
terface (M.2 SSDs with a SATA Interface are supported).
F - 26 Intel® Rapid Storage Technology
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PC Camera
Use the Fn + F10 key combination or Control Center button to toggle power to the PC Camera module. When
the PC Camera is in use the LED indicator to the left of the camera will be illuminated in red.

Note that you need to use the Camera app  in Windows to take pictures and capture video.

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera app from the Start menu by clicking on the Camera app icon  (you can type “camera” into 

the search box to find the Camera app if it is not pinned to the Start menu).
3. Click to select either photo  or video  modes.
4. Click the photo icon to take a picture, and the camera icon will briefly turn yellow as the picture is taken.
5. Click on the video icon  to start video capture (if video capture begins a timer will appear at the bottom of the 

screen and the icon will turn yellow).
6. To stop video capture click the video icon again.
7. Captured photos and videos will be saved to a Camera Roll folder within the Pictures/Videos folder in This 

PC, and to the Photos app stored in the Start menu (type Photos into the search box if you cannot find the 
app). 
PC Camera F - 27
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Trusted Platform Module
The TPM security chip allows you to create and manage digital certificates for user and platform authentica-
tion. This type of security is usually administered within large enterprises and organizations, and therefore re-
quires implementation by a system administrator before users can access security features. 

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full se-
curity protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store
passwords etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security platform (see “Enabling & Ac-
tivating TPM” on page 7 - 27).

TPM Management in Windows
1. Go to the Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.
4. The TPM Management window allows you to configure the TPM within Windows. As TPM is usually 

administered within large enterprises and organizations, your system administrator will need to assist you in 
managing the information here.

5. Click Prepare the TPM and follow the instructions in the Wizard to prepare the TPM (this will probably require a 
restart of the computer and confirmation of the setting changes after restart by pressing the appropriate F key).

6. After the restart the TPM will be prepared and you can then use the Actions menu to Turn TPM off, Change 
Owner Password, Clear TPM or Reset TPM Lockout.

7. A wizard will help take you through any setup steps.
F - 28 Trusted Platform Module
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3G/4G Module
If you have included an optional UMTS/HSPA+ based 3G Module (Universal Mobile Telecommunications
System or High Speed Packet Access) module or LTE (Long Term Evolution) 4G module (see “Communica-
tion (All Models)” on page D - 3 for specification details) in your purchase option, you do not require a driver/
application installation for Windows 10. See “3G/4G Module USIM Card Installation” on page 7 - 68 for in-
structions on installing the USIM card (which will be provided by your service provider). See overleaf for con-
nection information.


Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN mod-
ules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on,
make sure that the Bluetooth/Wireless LAN modules are powered off.
3G/4G Module F - 29
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3G/4G Configuration in Windows 10
You can configure a 3G/4G connection as below, however make sure the system is not in Airplane Mode before
configuration begins.

1. Click the Settings item in the Start Menu and then click Network and Internet.
2. Click Cellular a list of available access points will appear.
3. Click the access point and click Connect.
4. The system will connect to your network.
5. Connected will appear under the connection.
6. You can then access the internet, download e-mail etc. as per any internet connection.
7. To disconnect you can select the connection and click Disconnect.
8. You need to use Airplane Mode aboard aircraft.
9.  You can also click the Wireless icon  in the notification area of the taskbar, click Cellular and double-click an 

access point connect to access the connection information.
F - 30 3G/4G Module
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